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About this manual



Welcome!

This is the Operation Manual for Steinberg's Cubase SX/SL 2. Here
you will find detailed information about virtually all features and func-
tions in the program.

How to use the manuals and the Help

When it comes to manuals, different users look for information in dif-
ferent ways, depending on their previous knowledge and personal
preferences. You may be looking for a complete description of a pro-
cedure, you may just be trying to find a certain function in the program,
you may have found a function in the program and want it explained —
or you may simply want to learn it all!

Therefore, there are several ways to enter the documentation and get
help:

* Use the Table of Contents to browse the manual or the Help and find
the section you need to know more about.
You can click directly on a chapter or section to go there.

* Use the Index to look up specific features and functions.
Again, you can click directly on the page number for an index entry to go to there. The
help also allows you to perform a free search of any term.

* Inthe program you will find Help buttons in most dialogs - click to get
information about that specific dialog.
Similarly, you can press [F1] to get information about the current window.

* If you want information about a specific menu item, use the Menu
Reference section in the Help.
All main menu items in Cubase SX/SL are listed and explained there.

* Finally, you could read the manuals from start to end if you like.
See below for a description of all parts of the Cubase SX/SL documentation package.

CUBASE SX/SL
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Other documents

Apart from the Operation Manual and the help, the following docu-
ments are included with Cubase SX/SL:

Getting Started
In this book (also available in Adobe Acrobat pdf format) you will find:

* Requirements, installation and setting up your system.

+ Basic concepts and terminology.

* Basic methods - e.g. how to set values, use tools and menus.

» Alist of all default key commands.

* A number of tutorials, helping you get started with working in Cubase SX/SL.
Audio Effects and VST Instruments

In this pdf document you will find:

+ Descriptions of the included VST audio effect plug-ins.
» Descriptions of the included VST instruments.

These descriptions can also be found in the help.

Remote Control Devices

This pdf document lists the supported MIDI remote control devices
and describes how to set up and use them with Cubase SX/SL.

Score Layout and Printing (Cubase SX only)

This pdf document describes the advanced score editing features in
Cubase SX. For information about the basic score editor included in
Cubase SL, see page 586.

Using Cubase SX/SL with DSP Factory (Windows only)

In this pdf document you will find detailed information about Cubase
SX/SL's implementation for the Yamaha DSP Factory audio card.

3 All pdf documents can be opened from the Help menu in the program,
from the Cubase SX/SL Documentation subfolder on the Windows Start
menu or from the folder /Library/Documentation/Cubase SX/SL/ under
Mac OS X.

CUBASE SX/SL
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2

VST Connections: Setting up
input and output busses



About this chapter

As described in the Getting Started book, Cubase SX/SL uses a sys-

tem of input and output busses to transfer audio between the program
and the audio hardware.

* Input busses let you route audio from the inputs on your audio hardware into
the program. This means that when you record audio, you will always do this
through one or several input busses.

*  Output busses let you route audio from the program to the outputs on your
audio hardware. When you play back audio, you will always do this through
one or several output busses.

As you can see, the input and output busses are vital when you work
with Cubase SX/SL. That's the reason why you find this chapter in the
beginning of the Operation Manual — once you understand the bus sys-
tem and set up the busses properly, it will be easy to go on with record-
ing, playing back, mixing and doing surround work (Cubase SX only).

Setting up busses

Strategies

You can create any number of busses in Cubase SX/SL. In Cubase
SL, busses are in mono or stereo while Cubase SX also supports a
number of surround formats.

* The bus configuration is saved with the projects - therefore it’s a good
idea to add and set up the busses you need and save these in a template
project (see page 763).

When you start working on new projects, you start from this template. That way you
get your standard bus configuration without having to make new bus settings for each
new project. If you need to work with different bus configurations in different projects,
you could either create several different templates or store your configurations as pre-
sets (see page 20). The templates can of course also contain other settings that you
regularly use — sample rate, record format, a basic track layout, etc.

CUBASE SX/SL
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So, which type of busses do you need? This depends on your audio
hardware, your general audio setup (e.g. surround speaker setup) and
what kind of projects you work with. Here's an example:

Let's say you are using audio hardware with eight analog inputs and
outputs and digital stereo connections (10 inputs and outputs all in
all). Furthermore, you work with a surround setup in 5.1 format (rele-
vant for Cubase SX only). Here's a list of busses you may wish to add:

Input busses

Most likely you need at least one stereo input bus assigned to an analog input
pair. This would let you record stereo material. If you want to be able to record
in stereo from other analog input pairs as well, you could add stereo input
busses for these too.

Although you can record mono tracks from one side of a stereo input, it may
be a good idea to add a dedicated mono input bus. This could be assigned to
an analog input to which you have connected a dedicated microphone pre-
amp for example. Again, you could have several different mono busses.

You probably want a dedicated stereo input bus assigned to the digital stereo
input, for digital transfers.

If you want to transfer surround material directly to a surround track, e.g. from
surround-configured location recording equipment, you need an input bus in
that surround format (here, this would be a 5.1 input bus). Cubase SX only.

Output busses

You probably want one or several stereo output busses for monitoring and lis-
tening to stereo mixes.

For digital transfers, you need a stereo bus assigned to the digital stereo out-
put as well.

You need a surround bus in the format of your speaker configuration (here,
5.1) assigned to the correct outputs (which in turn are connected to the cor-
rect speakers). Again, this is available in Cubase SX only.

You may want additional surround busses if you tend to work in different sur-
round formats.

Different busses can use the same inputs/outputs on the audio hard-
ware! You may for example want a stereo output bus assigned to the

same outputs as the front stereo channels in your surround bus - this
makes it easy to listen to stereo mixes without having to reconnect.

CUBASE SX/SL

VST Connections: Setting up input and output busses | 2 - 15



Preparations

Before you set up busses, you should name the inputs and outputs on
your audio hardware. For example, if you are using a 5.1 surround
speaker setup, you should name the outputs according to which
speaker they are connected to (Left, Right, Center and so on).

The reason for this is compatibility — it makes it easier to transfer
projects between different computers and setups. For example, if you
move your project to another studio, the audio hardware may be of a
different model. But if both you and the other studio owner have given
your inputs and outputs names according to the surround setup (rather
than names based on the audio hardware model), Cubase SX/SL will
automatically find the correct inputs and outputs for your busses and
you will be able to play and record without changing the settings.

You name your inputs and outputs in the Device Setup dialog:
1. Open the Device Setup dialog from the Devices menu.

2. Select the VST Output Ports device in the list to the left and make
sure the Setup tab is selected.
The available output ports on your audio hardware are listed.

3. Torename a port, click its name in the list and type a new name.

* If needed, you can also disable ports by clicking in the “Visible” column
(so that it says “No”").
Disabled ports won't show up in the VST Connections window when you are making
bus settings. If you attempt to disable a port that is already used by a bus, you will be
asked whether that is really what you want — note that this will remove the port from the
bus!

4. Select the VST Input Ports and name them in the same way.
5. Click OK to close the Device Setup dialog.

* If you open a project created on another computer and the port names
don’t match (or the port configuration isn’t the same - e.g. the project is
created on a system with multi-channel i/o and you open it on a stereo
in/out system), a Pending Connections dialog will appear.

This allows you to manually re-route ports used in the project to ports available in your
system.

CUBASE SX/SL
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The VST Connections window

You add and set up busses in the VST Connections window, opened
from the Devices menu.

(’ VST Connections - Outputs g@
Inputs | Outputs | EE Al AddBus | Presets =]

qu MHame Speakers 4510 Device Port |
: Stereo Out Steren el
5.1

1 Analog Out 1/2 Delta- 1010 [1]
2 Analog Out 1/2 Delta- 100 [1]
Fanalog Out 3/4 Delta- 100 [1]
4 Analog Out 3/4 Delta- 1010 [1]
B Analog Out 5/6 Delta- 1010 [1]
B Analog Out 5/6 Delta- 1010 [1]

-

There are two tabs in the window, for viewing input busses or output
busses. Depending on which tab you have selected, the window lists
the current input or output busses, with the following three columns:

Column Description

Bus Name Lists the busses. You can select busses and rename them by clicking
on them in this column.

Speakers Indicates the speaker configuration (mono, stereo, surround formats)
of each bus.

ASIO Device  When you have “opened” a bus (by clicking its + button in the Bus
Port Name column) this column shows which physical input/output on your
audio hardware is used by the bus.

CUBASE SX/SL
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Adding a bus

1. Click the Inputs or Outputs tab depending on which type of bus you
want to add.

2. Click the Add Bus button.
A dialog appears.

- AddBus

3. Select the desired (channel) configuration.
The pop-up menu contains Mono and Stereo options as well as the most common sur-
round formats (Cubase SX only). To select another surround format, use the “More...”
submenu.

* Alternatively you can right-click (Win) or [Ctrl]-click (Mac) in the VST
Connections window and add a bus in the desired format directly
from the context menu that appears.

The new bus appears with the ports visible.

4. Click in the ASIO Device Port to select an input/output port for a
channel in the bus.
The pop-up menu that appears lists the ports with the names you have given them in
the Device Setup dialog. Repeat this for all channels in the bus.

CUBASE SX/SL
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Adding a child bus (Cubase SX only)

A surround bus is essentially a set of mono channels — 6 channels in
the case of 5.1 format. If you have a mono track in the project, you can
route it to a separate speaker channel in the bus (or route it to the
whole surround bus and use the surround panner to position it in the
surround image). But what if you have a stereo track that you simply
want to route to a stereo channel pair within the bus (Left and Right or
Left Surround and Right Surround for example)? For this you need to
create a child bus:

1. Select the surround bus in the list and right-click (Win) or [Ctrl]-click
(Mac) it.
A pop-up menu appears.

Bgs Mame Speakers ASID I

E| ----- Stereo Out Stereo
Left
Right

B £

Add Bus 4 1 s
Add Child Bus ¥ Stereo

Remove Bus Stereo (Ls Rs)

LFE %tereo (C Lfe)

Left Surraund LRC

£ Right Surround LRC+Lfe

Quadro
Quadro+Lfe

5.0

2. Select a channel configuration from the “Add Child Bus” submenu.
As you can see, you can create stereo child busses (routed to various speaker channel
pairs in the surround bus) or other surround bus formats (with fewer channels than the
“parent bus”).

The child bus you created will be available for direct routing in the
mixer. It's a part of the parent surround bus, which means there will be
no separate channel strip for it.

Although child busses are probably most useful in output busses, you
could also create child busses within a surround input bus - for exam-
ple if you want to record a stereo channel pair (e.g. front left-right) in
the surround bus to a separate stereo track.
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Other bus operations

* To change the port assignment for a bus you proceed as when you
added it — make sure the channels are visible (by clicking the + button
next to the bus, or by clicking the “+ All" button at the top of the win-
dow) and click in the ASIO Device Port column to select ports.

* Toremove a bus you don't need, select it in the list, right-click (Win) or
[Ctrl]-click (Mac) and select “Remove Bus” from the pop-up menu.

*  You can store and recall bus presets with the pop-up menu at the top
of the window.
To store the current configuration as a preset, click the store (+) button and enter a name
for the preset. You can then select the stored configuration directly from the Presets pop-
up menu at any time. To remove a stored preset, select it and click the (-) button.

CUBASE SX/SL
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Using the busses

This section describes briefly how to use the input and output busses
you have created. This is described in more detail in the chapters “Re-
cording” and “The mixer”.

Routing

When you play back an audio track (or any other audio channel in the
mixer — VST Instrument channels, ReWire channels, etc.), you route it
to an output bus. In the same way, when you record on an audio track
you select from which input bus the audio should be sent.

You can select input and output busses in the Inspector, using the
“In" and “Out” pop-up menus.

W 5.1 00t

Left

Right
Center
LFE %
Left Surround
Right Surround

Channel

For channel types other than audio tracks (VST Instrument channels,
FX channels, etc.), only the “Out” pop-up menu is available. To access
the “Out” pop-up menu for such a channel in the Inspector, select one
of its automation subtracks in the Track list.

You can also select busses in the Input and Output Settings panel at
the top of each channel strip in the mixer.

Again, for VST Instrument channels, ReWire channels, Group channels and FX chan-
nels you will only be able to select output busses.

CUBASE SX/SL
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* If the Input and Output Settings panel isn’t shown, click the Show Input
and Output Settings field in the common panel to the left in the mixer.

When selecting an input bus for a track you can only select busses that
correspond to the track’s channel configuration. Here are the details:

* Mono tracks can be routed to mono busses or individual channels within a ste-
reo or surround bus (input or output). You can also route a mono track to the
“whole" stereo or surround output bus, in which case a pan control (stereo pan
or surround panner) will be used to position the sound.

» Stereo tracks can be routed to stereo busses or stereo child busses within a
surround bus (input or output).

»  Surround tracks can be routed to busses with the same number of speaker
channels as the track (or to corresponding child busses within a “larger” sur-
round bus).

Viewing the busses in the mixer

In the Cubase SX mixer, busses are represented by input and output
channels (shown in separate panes to the left and right in the window).
You can show or hide these independently by clicking the buttons Hide
Input Channels and Hide Output Channels in the mixer's common
panel to the left:

— Hide Input Channels

E@lels

| B

™
ma
£
&b
m
a

— Hide Output Channels

Y

* In Cubase SL, only the output busses are visible in the mixer!
The input busses you have created in the VST Connections window are available for
selection on the input routing pop-up menus, but you cannot make any specific mixer
settings for the input busses.
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Input channels (shown in Cubase SX only)

oo [ oo |
(3]

] KIEE | T TR

The input channels are shown to the left in the mixer. As you can see,
each input channel resembles a regular mixer channel strip. Here you
can do the following:

* Check and adjust the recording level using the Input Gain knobs and/or the
level fader.
See page 47.

* Change the phase of the input signal.
This is done by clicking the Input Phase button next to the Input Gain control.

* Add effects or EQ to the input bus.
See page 61 for an example of how to add effects to your recording at the input bus
stage.

O The settings you make in the input channel strip will be a permanent part
of the recorded audio file!
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Output channels

The output channels are shown to the right in the mixer. Here you can
do the following:

* Adjust the total output level for the busses with the faders.
For stereo output busses you can also adjust the stereo balance with the pan control.

+ Add effects or EQ.
These will affect the whole bus. Examples of effects you may want to add here include
compressors, limiters and dithering. See page 241.

CUBASE SX/SL
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3

Playback and the Transport
panel



Background

This chapter describes the various methods available for controlling
Playback and Transport functions in Cubase SX/SL.

The Transport panel

Below you can find a brief description of each Transport panel item.

* You can customize the look of the Transport panel, hiding unneeded
controls and moving controls as desired — see page 790.
The pictures below show the Transport panel with all controls visible and in their de-
fault position (note that the Jog/Shuttle control is available in Cubase SX only). The
Transport panel is divided into sections, from left to right.

|4— Record mode pop-up

— Mormal =
&— Cycle Record
mode pop-up

-

CPU load and Disk Cache meters Activates Auto Quantize

Left locator: record start point, punch  Preroll setting and on/off switch

in point and beginning of Cycle J
Nudge +/- 1 Frame

Activates punch in ]
Jog Wheel (project

scrubbing)

Activates punch out
Shuttle speed

Right locator: punch out point Postroll setting and on/off switch

and end of Cycle

Primary Time Display and format pop-up  Exchange time formats ~ Secondary position dis-

'/- play and format pop-up
Nudge position ./

right/left *  40.0202035J | 00:01:19.201@
g/ >|e

Rewind \ Stop Play

start Fast forward Cycle on/off
Go to next marker or project end

Position slider Record

Go to previous
marker or project
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Precount on/off Show Markers (opens Marker window)

Metronome click on/off

Tempo follows Tempo
track on/off

TEIMPO st Jump to Marker

SYHE | IMT. =

Synchronization on/off \ The tempo and time signature display

Level Control (Output bus 1)

MIDI In (left meter)/
MIDI Out activity

Audio input activity (Input bus 1) Audio activity (Output bus 1)

¢ The main Transport functions (Cycle/Stop/Play/Record) can also be
shown on the toolbar.

= (<[> ]e]

In addition, various play options are available on the Transport menu.

Hiding and showing

The Transport panel is shown by default when you launch a new
project. To hide or show it, select the “Transport Panel” item from the
Transport menu (or use a key command — by default [F2]).

About Preroll and Postroll
These items are described in the chapter “Recording” — see page 79.
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Customizing the Transport panel

You can customize the appearance of the Transport panel by right-
clicking (Win) or [Ctrl]-clicking (Mac) anywhere on the panel and mak-
ing selections on the pop-up menu that appears.

v Performance

v Record Mode

v Locatars

v Jogyiscrub

v Main Transport

v Master + Sync

v Marker

w MIDT Ackivity

v Audio Activity

v Audio Level Control

Default

Transport Buttans
Buttons and Time Displays
Dual Time Displays

Mini Time Display

Skatus Fields Only

Jog Scrub and Markers

Setup...

*  On the upper half of the pop-up menu you can hide or show elements on the
panel by activating or deactivating the corresponding menu items.

+ Selecting the Show All item displays all sections of the Transport panel.

+ Selecting Default shows all sections in their default positions on the panel.

* The items in the lower half of the pop-up menu are preset configurations for
the Transport panel. You will also find your own stored presets here, for quick
selection.

» Selecting Setup brings up a dialog where you can set show/hide status for
the separate sections, configure where the sections should be placed on the
panel and store different Transport panel layouts as presets for instant recall.

For more about customizing the Transport panel, see page 790.
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The numeric keypad

In the default Key Command settings, the numeric keypad on the
computer keyboard is assigned various Transport panel operations
The keypads are slightly different on PC and Macintosh computers:

PC:

Cycle On/Off — 7 N a0
Num
Lock F X =)
y J J
F ) \ \
Go to Marker — |
number 3-9 { |8

N

+
J\ J J y
Go to right locator —{f- A 9[? Tj 3 N (( ) Play
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Fast Forward

Return to Zero

Fast Forward
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Operations

Setting the project cursor position

There are several ways to move the project cursor position:

* By using Fast Forward and Rewind.

* By using the Jog/Shuttle/Nudge control on the Transport panel (Cubase SX
only - see page 33).

* By dragging the project cursor in the lower part of the ruler.

* By clicking in the ruler.

Double clicking in the ruler moves the cursor and starts/stops playback.

* If the option “Locate when Clicked in Empty Space” is activated in the Prefer-
ences dialog (Transport page) you can click anywhere in an empty section of
the Project window to move the cursor position.

* By changing the value in any of the position displays.

* By using the position slider above the transport buttons.

The range of the slider relates to the Length setting in the Project Setup dialog. Hence,
moving the slider all the way to the right will take you to the end of the project.

By using markers (see page 154).

+ By using playback options (see page 35).

* By using functions on the Transport menu.

The following functions are available:

Function Description

Locate Selection Moves the project cursor to the beginning of the current se-
lection. For this to be available, you must have selected one
or more events or parts, or made a selection range.

Locate Next/Previous  This moves the project cursor to the closest marker to the right
Marker or left (see page 154).

Locate Next/Previous  This moves the project cursor forwards or backwards respec-
Event tively, to the closest beginning or end of any event on the se-
lected track(s).

* If Snap is activated when dragging the project cursor, the Snap value is
taken into account. This can be helpful for finding exact positions quickly.

* There are also numerous key commands available for moving the
project cursor (in the Transport category in the Key Commands dialog).
For example, you can assign key commands to the “Step Bar” and “Step Back Bar” func-
tions, allowing you to move the project cursor in steps of one bar, backwards and forwards.
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About the Transport panel display formats

*  40.0202035. | 00:01:19.201@

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from the time unit
shown in the main time display on the Transport panel. This means
that you can display timecode in the transport position display and
bars and beats in the ruler, for example. In addition, there is a second-
ary time display to the right of the primary time display which is also in-
dependent, giving you three different time units shown at the same
time (in the Project window, you can also create additional ruler tracks
- see page 97).

The following rules apply:

* |f you change the time format from the primary time display on the
Transport panel, this will apply to the ruler as well.
This is the same as changing the display format in the Project Setup. Therefore, to
have different display formats in the ruler and the main time display you should change
the format in the ruler.

e The primary time display format is set on the pop-up menu to the right
in the main position display.

*  400202035. [ o00:01:19.201@ fIB
| === Bars+Beats i
T Timecode

Samples
60 Fps {User) —

¢ The setting here also determines the time format displayed for the left
and right locators.

* The secondary time display is completely independent, and the display
format is set on the pop-up menu to the right in the secondary position
display.

* You can swap time formats between the primary and secondary time
displays by clicking the double arrow symbol between them.
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The left and right locators

The left and right locators are a pair of position markers used for spec-
ifying punch-in and punch-out positions during recording, and as
boundaries for cycle playback and recording.

* When cycle mode is activated on the Transport panel, the area between
the left and right locator will be repeated (cycled) on playback.
However, if the right locator is positioned before the left, this will work as a “jump” or
“skip mode” — when the project cursor reaches the right locator it will immediately
jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

* To set the left locator, press [Ctrl]l/[Command] and click at the de-
sired position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can
also drag the locator “handles” directly in the ruler.

r I ]
9 17 25
I 1

The locators are indicated by the “flags” in the ruler. The area between the locators
is highlighted in the ruler and in the Project window (see page 801). Note that if the
right locator is before the left locator the area will be red in the ruler to indicate this.

* Click and drag in the upper half of the ruler to “draw” a locator range.
If you click on an existing locator range, you can drag to move it.

* Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric
keypad sets the left or right locator to the project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command])
to set the project cursor position to the left or right locator position. Note that these are
default key commands - you can change these if you like.

* By creating cycle markers you can store any number of left and right
locator positions, which can be recalled by simply double clicking on
the corresponding marker (see page 158).

* The “Locators to Selection” item on the Transport menu (default key
command [P]) sets the locators to encompass the current selection.
This is available if you have selected one or several events or made a selection range.

* You can also adjust the locators numerically in the Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will move the
project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R
button, the corresponding locator will be set to the current project cursor position.
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The Shuttle Speed control (Cubase SX only)

e > o

The shuttle speed control (the outer wheel on the Transport panel) al-
lows you to play the project at any playback speed, forwards or back-
wards. This provides a quick way to locate or “cue” to any position in
the project.

* Turn the shuttle speed wheel to the right to start playback.
The further to the right you move the wheel, the faster the playback speed. You don't
have to keep the mouse button pressed - playback will continue until you stop it.

¢ |f you turn the wheel to the left instead, the project will play backwards.
Similarly, the playback speed depends on how far to the left you turn the wheel.

* To stop playback, click Stop as usual or turn the shuttle speed wheel
to the middle position.

Project scrubbing - the Jog Wheel (Cubase SX only)

o~ 01.04.0
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The middle wheel on the Transport panel serves as a jog wheel. By
clicking and dragging it to the right or left you will move the playback
position manually forwards or backwards — much like scrubbing on a
tape deck. This helps you pinpoint exact locations in the project.

* Note that the jog wheel is an “endless dial” — you can turn it as many
times as needed to move to the desired location.
The faster you turn the wheel, the faster the playback speed.

* If you click the jog wheel during playback, playback will automatically
stop.
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The nudge position buttons (Cubase SX only)

The + and - buttons in the middle of the Shuttle/Jog Wheel allows you
to nudge the project cursor position to the right or left, respectively.
Each time you click a nudge button, the project cursor is moved by
one frame.

Options and Settings

The “Return to Start Position on Stop” preference

This setting is found on the Transport page in the Preferences dialog
(found on the File menu under Windows, on the Cubase SX/SL menu
under Mac OS X).

* If “Return to Start Position on Stop” is activated when you stop play-
back, the project cursor will automatically return to the position where
recording or playback last started.

* If “Return to Start Position on Stop” is deactivated, the project cursor
will remain at the position where you stop playback.
Pressing Stop again will return the project cursor to the position where recording or
playback last started.

About track disable/enable

For audio tracks, the track context menu contains an item named “Dis-
able Track”. This shuts down all disk activity for the track, as opposed
to using Mute, which merely turns down the output volume for a track.
For example, if you often record “alternative takes” you can easily build
up a large number of takes on different tracks. Even though these
tracks are muted, they are actually still “playing back” from the hard
disk during playback. This puts an unnecessary load on your disk sys-
tem, so using “Disable Track” is recommended for such situations.

* Select “Disable Track” for tracks that you want to keep in the project
for later use (but don't want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled tracks.
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Playback functions

Apart from the standard transport controls on the Transport panel, you
can also find a number of functions that can be used to control play-
back on the Transport menu. The items have the following functionality:

Option

Play from Selection Start

Play from Selection End

Play until Selection Start

Play until Selection End

Play until Next Marker

Play Selection Range

Loop Selection

Description

This activates playback from the beginning of the currently
selected range.

This activates playback from the end of the currently se-
lected range.

This activates playback two seconds before the start of the
currently selected range and stops at the selection start.

This activates playback two seconds before the end of the
selected range and stops at the selection end.

This activates playback from the project cursor and stops at
the next marker.

This activates playback from the start of the selected range
and stops at the selection end.

This activates playback from the start of the selected range
and continuously starts over again upon reaching the selec-
tion end.

(0 The functions listed above (except “Play until Next Marker”) are only avail-
able if you have selected one or more events or made a selection range.
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About Chase

Chase is basically a function that makes sure your MIDI instruments
sound as they should when you locate to a new position and start
playback. This is accomplished by having the program transmitting a
number of MIDI messages to your instruments each time you move to
a new position in the project, making sure all MIDI devices are set up
correctly with regard to program change, controller messages (such
as MIDI Volume) etc.

For example, let's say you have a MIDI track with a program change
event inserted at the beginning. This event makes a synth switch to a
piano sound.

In the beginning of the first chorus you have another program change
event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then
switches to the string sound. In the middle of the chorus you stop and
rewind to some point between the beginning and the second program
change. The synth will now still play the string sound although in this
section it really should be a piano!

The Chase function takes care of that. If program change events are
set to be chased, Cubase SX/SL will track the music back to the be-
ginning, find the first program change and send this out, so that the
synth is set to the right sound.

The same thing can apply to other event types as well. The Chase
Events settings in the Preferences dialog—MIDI page determine which
event types will be chased when you locate to a new position and
start playback.

Chase Everts

M Note

Paly Pressure
Contraller
Program Change
Aftertouch
Pitzhbend

W Syzex

* Event types for which the checkbox is activated here will be chased.
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Recording



Background

This chapter describes the various recording methods that you can
use in Cubase SX/SL. As it is possible to record both audio and MIDI
tracks in Cubase SX/SL, both these recording methods are covered
in this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain ba-

sic recording concepts, and that the following initial preparations have
been made:

* You have properly set up, connected and calibrated your audio hard-
ware.
This is described in the Getting Started book.

* You have opened a project and set the project setup parameters to
your specifications.
Project setup parameters determine the record format, sample rate, project length etc.
that affect the audio recordings you make during the course of the project. See page 99.

* If you plan to record MIDI, your MIDI equipment should be set up and
connected correctly.
See the Getting Started book.
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Basic recording methods

This section describes the general methods used for recording. How-
ever, there are additional preparations and procedures that are specific
to audio and MIDI recording respectively. Make sure to read these sec-
tions before you start recording (see page 43 and page 65).

Record enabling a track

Cubase SX/SL can record on a single track or on several tracks (au-

dio and/or MIDI) simultaneously. To make a track ready for recording,

click the Record Enable button for the track in the Track list, in the In-
spector or in the mixer. When activated, the button(s) turn red, indicat-
ing record ready mode.

Audio 01

uBR=R] - cio 01|
Mono q}y R W

mi =

Record Enable in the Inspector, Track list and mixer.

¢ If the option “Enable Record on Selected Track” is activated in the Pref-
erences dialog (Editing page), tracks are automatically record enabled
when you select them in the Track list.

¢ The exact number of audio tracks you can record simultaneously depends
on your computer CPU and hard disk performance.
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Manually activating recording

You activate recording by clicking the Record button on the Transport
panel or toolbar, or by using the corresponding key command (by de-
fault [*] on the numeric keypad).

Recording can be activated from Stop mode (from the current cursor
position or from the left locator) or during playback:

* If you activate recording from Stop mode, and the option “Start Record at Left
Locator" is activated on the Transport menu, recording will start from the left
locator.

The preroll setting or the metronome count-in will be applied (see page 79).

* If you activate recording from Stop mode, and “Start Record at Left Locator” is
deactivated, recording will start from the current project cursor position.

* If you activate recording during playback, Cubase SX/SL willimmediately enter
Record mode and start recording at the current project cursor position.

This is known as “manual punch in".

Activating recording in Sync mode

If you are synchronizing the Cubase SX/SL transport to external equip-
ment (Sync is activated on the Transport panel) and you activate re-
cording, the program will go into “record ready” mode (the record
button on the Transport panel will light up). Recording then starts when
a valid timecode signal is received (or when you manually click the Play
button). See page 706 for more information about synchronization.

CUBASE SX/SL
4 — 40 | Recording



Automatically activating recording

Cubase SX/SL can automatically switch from playback to recording
at a given position. This is known as “automatic punch in". A typical
use for this would be if you need to replace a section of a recording,
and want to listen to what is already recorded, up to the recording
start position.

1. Set the left locator to the position where you want recording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left locator.
When the project cursor reaches the left locator, recording is automatically activated.

Stopping recording
Again, this can be done automatically or manually:

¢ If you click the Stop button on the Transport panel (or use the corre-
sponding key command, by default [0] on the numeric keypad), re-
cording is deactivated and Cubase SX/SL goes to Stop mode.

* If you click the Record button or use the key command for recording,
by default [*], recording is deactivated but playback continues.
This is known as “manual punch out”.

* If the Punch Out button is activated on the Transport panel, recording
will be deactivated when the project cursor reaches the right locator.
This is known as “automatic punch out”. By combining this with automatic punch in,
you can set up a specific section to record — again very useful if you want to replace a
certain part of a recording. See also page 78.

Punch In and Out activated.
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Cycle recording

Cubase SX/SL can record and play back in a cycle — a loop. You spec-
ify where the cycle starts and ends by setting the left and right locators.
When the cycle is active, the selected section is seamlessly repeated
until you hit Stop or deactivate cycle mode.

* To activate cycle mode, click the cycle button on the Transport panel.
If you now start playback, the section between the left and right locator is repeated in-
definitely until you stop.

» DIl o
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Cycle activated

* Torecord in cycle mode, you can start recording from the left locator,
from before the locators or from within the cycle, from Stop mode or
during playback.

As soon as the project cursor reaches the right locator, it will jump back to the left lo-
cator and continue recording a new lap.

* The results of cycle recording depend on the selected cycle record
mode and are different for audio (see page 55) and MIDI (see page 71).
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Audio recording specifics

Selecting a recording file format

The format of recorded files is set in the Project Setup dialog on the
Project menu. There are three settings: sample rate, record format (bit
depth) and record file type. While the sample rate is set once and for
all when you start working on a new project, the bit depth and file type
can be changed at any time.

Record file type

The Record File Type setting determines which type of files will be cre-
ated when you record:

File type Description

Wave File Wave files have the extension “.wav” and are the most common file for-
mat on the PC platform.

Wave 64 File Wave64 is a proprietary format developed by Sonic Foundry Inc. Audio-

(Cubase SX wise it is identical to the Wave format, but the internal file structure

only) makes much larger file sizes possible. This is useful e.g. for long live re-
cordings in surround format, where the audio files could become huge.

Broadcast In terms of audio content, the same as regular Wave files, but with em-
Wave File bedded text strings for supplying additional information about the file
(see below).

AIFF File Audio Interchange File Format, a standard defined by Apple Computer
Inc. AIFF files have the extension “.aif" and are used on most computer
platforms. Like Broadcast Wave files, AIFF files can contain embedded
text strings (see below).

* |f you select Broadcast Wave File or AIFF format, you can specify
Author, Description and Reference text strings that will be embedded
in the recorded file.

This is done on the Record-Broadcast Wave page in the Preferences dialog.
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Record format (bit depth)

The available options are 16 bit, 24 bit and 32 bit float. Use the follow-
ing guidelines:

* Normally, select the record format according to the bit depth delivered by your
audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), you may want
to record at 24 bit resolution, to capture the full bit depth. On the other hand, if your
hardware has 16 bit inputs, it's pointless to record with a higher bit depth - this will
only make the audio files larger, with no difference in audio quality. The exception is if
you record with effects — see page 61 for an example of this.

* The higher the bit depth, the larger the files and the more strain is put on the
disk system.
If this is an issue, you may want to lower the record format setting.

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo or surround tracks
(Cubase SX only). This allows you to record or import a file containing
multiple channels and treat it as one entity, with no need to split it up
into several mono files etc. The signal path for an audio track main-
tains its channel configuration all the way from the input bus, via EQ,
level and other mixer settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select Add Audio Track from the Track list context menu or the Project
menu (or double click in an empty area of the Track list when an audio
track is selected — when a MIDI track is selected, double clicking in
the Track list creates a new MIDI track).

A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
In Cubase SL you choose between mono and stereo; in Cubase SX the most common
formats are listed directly on the pop-up menu with the remaining surround formats listed
on the “More..." submenu. For a list of the available surround formats, see page 283.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer, a corresponding
channel strip appears. Note that you cannot change the channel configuration for a track.
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Selecting an input bus for a track

Here we assume that you have added and set up the required input
busses (see page 14). Before you record you need to specify from
which input bus the track should record. You can do this in the In-
spector or in the mixer:

In the Inspector you select an input bus on the “in” pop-up menu in the
top section.

As described on page 88, the Inspector shows the settings for the selected track. You
show or hide the Inspector using the Inspector icon on the Project window toolbar.

Click here to show/hide the Inspector.

0 e
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Click here to select an input
bus for the track.

In the mixer you select an input bus on the Input Routing pop-up menu
at the top of the track’s channel strip.

If this pop-up menu isn’t shown, you need to click the Show Input and Output Settings
field in the common panel to the left. See page 183 for more about the mixer.

Click here to
select an input
bus for the
track.

Click here to
show or hide the
input and output
settings.
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Selecting a folder for the recorded audio files (Cubase SX only)

As described in the Getting Started book, each Cubase SX/SL project
has a project folder containing (among other things) an “Audio” folder.
By default, this is where recorded audio files are stored. However, in
Cubase SX you can select record folders independently for each au-
dio track if needed:

1. To select the same record folder for several audio tracks, you need to
select them by [Shift]- or [Ctrl]]/[Command]-clicking in the Track list.

2. Right-click (Win) or [Cirl]-click (Mac) in the Track list for one of the
tracks to bring up the track context menu.

3. Select “Set Record Folder”.

4. Use the file dialog that appears to navigate to the desired folder (or
create a new folder with the Create button).
Tip: if you want to have separate folders for different types of material (speech, ambi-
ent sounds, music, etc.) you can create subfolders within the Project’s “Audio” folder
and assign different tracks to different subfolders. This way, all audio files will still re-
side within the project folder which will make managing the Project easier.

* |t's fully possible to have different tracks record to totally different lo-
cations, on different disks if you like. However, if you need to move or
archive the Project, there is a risk of missing some files. The solution is
to use the Prepare Archive function in the Pool to gather all external
files into the project folder first — see page 440.
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Setting input levels

When recording digital sound, it's important to set the input levels
correctly — loud enough to ensure low noise and high audio quality,
but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware, when a too loud ana-
log signal is converted to digital in the hardware’s A/D converters.

* If you are using Cubase SX it is also possible to get clipping when the
signal from the input bus is written to a file on your hard disk.
This is because in Cubase SX you can make settings for the input bus, adding EQ, ef-
fects, etc. to the signal as its being recorded. This may raise the level of the signal,
causing clipping in the recorded audio file.

The procedure for checking the signal level coming into the audio hard-
ware is slightly different depending on whether you are using Cubase
SX or Cubase SL:

Cubase SX
In Cubase SX you check the input level at the input channel.

To check the level of the “unprocessed” signal coming into the audio
hardware you need to switch the level meters to “Input VU". In this
mode the input channel level meters will show the level of the signal at
the input of the bus, before any adjustments such as input gain, EQ,
effects, level or pan:

1. Right-click (Win) or [Ctrl]-click (Mac) in the Mixer window.

The Mixer context menu appears.

2. Select the VU-Meter Settings submenu and make sure “Input VU" is
activated.

3. Play back the audio and check the level meter for the input channel.
The signal should be as loud as possible without exceeding 0 dB (the Clipping indica-
tor for the input bus should not light up).

The Clipping indicator.
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4. If necessary, adjust the input level in one of the following ways:
* Adjust the output level of the sound source or external mixer.

* Use the audio hardware’s own application program to set the input
levels, if this possibility is provided.
See the documentation for the audio hardware.

* If your audio hardware supports the ASIO Control Panel function, it
may be possible to make input level settings.
To open the ASIO control panel, open the Device Setup dialog on the Devices menu
and click the Control Panel button on the Setup tab for the VST Multitrack device.

The next step is to check the level of the audio being written to a file
on your hard disk. This is only necessary if you have made any adjust-
ments to the input channel (level settings, EQ, insert effects, etc.).
Note also:

* If you record in 32 bit float format the bit depth will not be reduced -
which means there's no risk of clipping at this stage.
Also, this preserves the signal quality perfectly. Therefore, you should consider using
32 bit float format when you are recording with effects (see page 61).

* If yourecord in 16 or 24 bit format the available headroom is lower
which means clipping can occur if the signal is too loud.
To avoid this, set the signal level in the following way:

1. Bring up the mixer context menu and select “Post-Fader VU” from the
VU-Meter Settings submenu.

2. Set up the input channel, adding EQ and/or effects as desired.
With some effects you may want to adjust the level of the signal going into the effect -
use the Input Gain knob for this. Note that you need to press [Shift] or [Alt]/[Option] to
adjust the Input Gain.

3. Play back the audio and check the level meter of the input channel.
The signal should be reasonably loud but should not reach 0 dB (the Clipping indicator
for the input bus should not light up).

4. If necessary, use the input channel fader to adjust the signal level.
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Cubase SL

In Cubase SL, the input channels are not shown in the mixer. Instead,
you need to check the level at the channel strip for the track on which
you are recording:

1. Right-click (Windows) or [Ctrl]-click (Mac) somewhere in the Mixer
window to bring up the Mixer context menu.

2. Select the VU-Meter Settings submenu and make sure “Input VU" is
activated.
In this mode, the level meters show the levels “pre-fader” — that is, unaffected by level
fader changes, EQ, insert effects, etc.

3. Locate the channel strip for the track you're about to record on.

4. Activate monitoring for the channel by clicking the speaker button next
to the fader.
When monitoring is activated, the meter shows the level of the incoming audio signal.

5. Play the audio source that you want to record and check the level
meter for the channel.

6. Adjust the output level of your audio source so that the meters go rea-
sonably high without reaching 0.0 dB.
Check the numerical peak level indicator below the meter in the bus channel strip. To
reset the peak level indicator, click on it.

¢ You must adjust the output level of the audio source - you cannot use
the faders in Cubase SL to adjust the input level!

* An alternative way of checking the input levels would be to use the control
panel for your audio hardware (if it's equipped with input level meters). It
may also be possible to adjust the input level in the control panel.

See the documentation of the audio hardware for details.
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Monitoring

In this context, “monitoring” means listening to the input signal during
recording. There are three fundamentally different ways to do this: via
Cubase SX/SL, externally (by listening to the signal before it reaches
Cubase SX/SL) or by using ASIO Direct Monitoring (which is a combi-
nation of both of the other methods — see page 52).

Monitoring via Cubase SX/SL

If you monitor via Cubase SX/SL, the input signal is mixed in with the
audio playback. The advantage of this is that you can adjust the moni-
toring level and panning in the mixer, and add effects and EQ to the
monitor signal just as during playback (using the track’s channel strip —
not the input bus!).

The disadvantage of monitoring via Cubase SX/SL is that the moni-
tored signal will be delayed according to the latency value (which de-
pends on your audio hardware and drivers). Therefore, monitoring via
Cubase SX/SL requires an audio hardware configuration with a low la-
tency value (see the Getting Started book). You can check the latency
of your hardware in the Device Setup dialog (VST Multitrack page).

* If you are using plug-in effects with large inherent delays, the automatic
delay compensation function in Cubase SX/SL will increase the latency.
If this is a problem you can use the Constrain Delay Compensation function while re-
cording - see page 270.

When monitoring via Cubase SX/SL, you can select one of four
modes in the Preferences dialog (VST page):

VST
min| 111} max  Scrub Response [Speed)]
min | 111} max  Scrub Yalume

tdanual

| v Manual 2k's Hold Time
‘While Record Enabled

| while Record Running hids
T hine Skl "
| e & flified Effects
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*  Manual.
This option allows you to turn input monitoring on or off by clicking the Monitor button
in the Inspector, the Track list or in the mixer.

*  While Record Enabled.
With this option you will hear the audio source connected to the channel input when-
ever the track is record enabled.

*  While Record Running.
This option switches to input monitoring only during recording.

» Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in Stop mode
and during recording, but not during playback.

External monitoring

External monitoring (listening to the input signal before it goes into
Cubase SX/SL) requires some sort of external mixer for mixing the au-
dio playback with the input signal. This can be a stand-alone physical
mixer or a mixer application for your audio hardware, if this has a mode
in which the input audio is sent back out again (usually called “Thru”,
“Direct Thru" or similar).

When using external monitoring, you cannot control the level of the
monitor signal from within Cubase SX/SL, or add VST effects or EQ
to the monitor signal. The latency value of the audio hardware config-
uration does not affect the monitor signal in this mode.

¢ |f you want to use external monitoring, you need to make sure that mon-
itoring via Cubase SX/SL isn't activated as well.
Select the “Manual” monitoring mode in the Preferences dialog (VST page) and simply
don't activate the Monitor buttons.
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ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO
Direct Monitoring. In this mode, the actual monitoring is done in the
audio hardware, by sending the input signal back out again. However,
monitoring is controlled from Cubase SX/SL. This means that the au-
dio hardware's direct monitoring feature can be turned on or off auto-
matically by Cubase SX/SL, just as when using internal monitoring.

* To activate ASIO Direct Monitoring, open the Device Setup dialog on
the Devices menu and use the Direct Monitoring checkbox on the
Setup tab for the VST Multitrack device.

If the checkbox is greyed out, your audio hardware (or its driver) doesn’t support ASIO
Direct Monitoring. Consult the audio hardware manufacturer for details.

*  When ASIO Direct Monitoring is activated, you can select a monitor-
ing mode in the Preferences dialog (VST page), as when monitoring
via Cubase SX/SL (see page 50).

* Depending on the audio hardware, it may also be possible to adjust
monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

* VST effects and EQ cannot be applied to the monitor signal in this
mode, since the monitor signal doesn't pass through Cubase SX/SL.

* Depending on the audio hardware, there may be special restrictions
as to which audio outputs can be used for direct monitoring.
For details on the routing of the audio hardware, see its documentation.

* The latency value of the audio hardware configuration does not affect
the monitor signal when using ASIO Direct Monitoring.

CUBASE SX/SL
4 - 52 | Recording



Recording

Recording is done using any of the general recording methods (see
page 39). After you finish recording, an audio file has been created in
the Audio folder within the project folder. In the Pool, an audio clip is
created for the audio file, and an audio event that plays the whole clip
appears on the recording track. Finally, a waveform image is calculated
for the audio event. If the recording was very long, this may take a while.

¢ |f the option “Create Audio Images During Record” is activated in the
Preferences dialog (Record page), the waveform image will be calcu-
lated and displayed during the actual recording process.
This real-time calculation uses some processing power — if your processor is slow or
you are working on a CPU-intensive project you should consider turning this option off.

Undoing recording

If you decide that you don't like what you just recorded, you can delete
it by selecting Undo from the Edit menu. The following will happen:

* The event(s) you just created will be removed from the Project window.

* The audio clip(s) in the Pool will be moved to the Trash folder.

* The recorded audio file(s) will not be removed from the hard disk.
However, since their corresponding clips are moved to the Trash folder, you can delete
the files by opening the Pool and selecting “Empty Trash” from the Pool menu.

CUBASE SX/SL
Recording | 4 - 53



Recording overlapping events

The basic rule for audio tracks is that each track can play back a sin-
gle audio event at a time. This means that if two or more events are
overlapping, only one of them will be heard at any given time.

What happens when you record overlapping events (record in an area
where there's already events on the track) depends on the Linear
Record Mode setting on the Transport panel:

] v Mormal
Merge
Replace

* In“Normal” or “Merge” mode, recording where something has already
been recorded creates a new audio event that overlaps the previous
one(s).

When you record audio there is no difference between “Normal” and “Merge” mode -
the difference only applies to MIDI recording (see page 70).

* In “Replace” mode, existing events (or portions of events) that are
overlapped by the new recording will be removed.
This means that if you record a section in the middle of a longer existing recording, that
original event will be cut into two events with a gap for the new event.

J
gl Evert

[Ty
Qe Event Dld Event

Which event will be heard?

If two or more events are overlapping, you will only hear the events (or
portions of events) that are actually visible. Overlapped (hidden) events
or sections are not played back.

¢ The functions “Move to Front” and “Move to Back” on the Edit menu
(see page 121) are useful for managing overlapping events, as is the
“To Front” function (see below).
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Recording audio in cycle mode

If you are recording audio in cycle mode, the result depends on two
factors:

e The Cycle Record Mode setting on the Transport panel.

¢ The “Audio Cycle Record Mode" setting in the Preferences dialog
(Record page).

Cycle Record Modes on the Transport panel

EIRL v Mix (MIDD

Cverwrite (MIDD)

[%Keep Lask
Stacked

There are four different modes on the Transport panel, but the differ-
ences between two of the modes only apply to MIDI recording. For
audio cycle recording, the following applies:

e If“Keep Last" is selected, the last complete “take” (the last completely
recorded lap) is kept as an audio event.
In reality, all laps you recorded are saved in one audio file divided into regions — one re-
gion for each take. You can easily select a previous take for playback - this is done as
when recording in “Create Regions" mode (see page 57).

* |f “Stacked” is selected, each take will appear as an event on a separate
“lane” on the track.
This is useful when you want to view and edit the different takes and eventually com-
bine them to one recording. In this mode, the Audio Cycle Record Mode preference
doesn't matter. See page 59.

* Ifany of the other cycle recording modes is selected, the result depends
entirely on the Audio Cycle Record Mode setting in the Preferences.
These options are described below.

CUBASE SX/SL
Recording | 4 - 55



Create Events mode (Preferences)

Create R

v Create Regions
Create Events %
| create Events + gions

When Audio Cycle Record Mode (Preferences—Record page) is set
to “Create Events”, the following will happen when you record audio
in cycle mode:

cord

*  One continuous audio file is created during the entire recording process.

* For each recorded lap of the cycle, one audio event is created.
The events will have the name of the audio file plus the text “Take *", where “*" indi-
cates the number of the take.

* The last take (the last recorded lap) will be on top (and will thus be the one
you hear when you activate playback).

To select another take for playback, proceed a follows:

1. Right-click (Win) or [Ctrl]-click (Mac) the event and select “To Front”
from the pop-up menu that appears.
A submenu appears, listing all the other (obscured) events.

To Fronk r Take 1 {Mew event)
ﬁk& 2 (MNew event)

k Object Selection ke 3 (New event)

I~ Range Selection

2. Select the desired take.
The corresponding event is brought to front.
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This method allows you to quickly combine the best parts of each
take, in the following way:

1. Use the Scissors tool to split the events in several sections, one for
each part of the take.
For example, if you recorded four lines of vocals (in each take), you can split the events
so that each line gets a separate event.

Take 1 [New euenﬂ Take & (New event)| Take 3 (New event) Tgkq

The events after splitting. Note that since the original take events overlap each
other, clicking with the Scissors tool will split all takes at the same position.

2. For each section of the take, use the “To Front” function to bring the
best take to the front.
This way, you can quickly combine the best sections of each take, using the first vocal
line from one take, the second line from another take and so on.

You can also compile a “perfect” take in the Audio Part Editor, as de-
scribed on page 394.

Create Regions mode (Preferences)

When Audio Cycle Record Mode (Preferences—Record page) is set
to “Create Regions”, the following will happen when you record audio
in cycle mode:

*  One continuous audio file is created during the entire recording process.

* The audio event in the Project window shows the name of the audio file plus
the text “Take *" (with “*" being the number of the last completed cycle lap).

* If you play back the recorded event, you will only hear what was recorded dur-
ing the last lap of the cycle recording.
The previous “takes” recorded in the cycle are still available, however.

* The audio clip is divided into regions (called takes), one for each lap of the cycle
that was recorded.
If you locate the audio file you just recorded in the Pool, and click on the plus sign be-
side it, you can see the regions that have been created, one for each lap of the cycle
that was completed during recording.
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“Take" regions in the Pool window.
To play back the different “takes”, proceed as follows:

1. In the Project window, right-click (Win) or [Ctrl]-click (Mac) the event
that was created during cycle recording.
The Quick menu appears.

2. Select the “Set To Region” menu item.
A submenu appears with the takes you recorded during cycle record.

3. Now you can freely select any of the takes from the submenu and it
will replace the previous take event in the Project window.

Set To Region k Take 1
Take 2

k COhject Selection % Take 3
I 1 Range Selection Take 4
\E:‘ Split W Take 5

Use this method to listen through the various takes. Select the best
single take, or compile a “perfect” take by cutting out the best bits from
each take and putting them together (see page 394).

Create Events + Regions mode (Preferences)

In this mode, both events and regions are created. If you work with the
takes as events in this mode, you can edit the events freely (e.g. splitting
them as described on page 56). However, in case you want to go back
to the original takes, they are still available as regions (on the “Set To
Region” submenu, in the Pool or in the Sample Editor).
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Recording audio in Stacked mode

When you record audio in cycle mode and the “Stacked” Cycle Record
Mode is selected on the Transport panel, the following happens:

» Each complete recorded cycle lap is turned into a separate audio event.
* The track is divided into “lanes”, one for each cycle lap.
* The events are stacked above each other, each on a different lane.

4= o 2 T.‘f;: a"-ﬂ'.‘ 05-:
e R W) s'e_L(u.l-:-f} —
e) =)= Take 2 (Audio 01_05) =
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Take 3 (Audio 0_05) =]
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This makes it easy to create a “perfect take” by combining the best
parts from the different cycle laps:

1. Zoom in so you can work comfortably with the stacked events.

If you play back the recorded section, only the lowest (last) take will
be heard.

2. To audition another take, either mute the lower take(s) with the Mute
tool or move the takes between the lanes.
This can be done by dragging or by using the functions Move to Next Lane/Previous
Lane on the Quick menu or Edit menu.
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3. Edit the takes so that only the parts you want to keep can be heard.
You can cut events with the Scissors tool, resize them, mute them or delete them.

Take 1 (Audl
Take 2 (AUl Take 2 (AW
el

el

O

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all events on all lanes
and select “Delete Overlaps” from the Advanced submenu on the Au-
dio menu.

This puts all events back on a single lane and resizes events so that overlapped sec-
tions are removed.

Wfaobd

Fak) Take L Andio 0 | AW Take 3 Audi

5. To turn off the lane display mode for the track, click the Lane Display
Type button in the track list and select “Lanes Off".
If the button is hidden, you can bring it to view in the Track Controls Settings dialog -
see page 794.

m) s |[TTTEE =) ©
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The Lane Display Type button.
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Recording with effects (Cubase SX only)

Normally you record the audio signals “dry” and add effects non-de-
structively during playback as described in the chapter “Audio effects”.
However, Cubase SX also allows you to add effects (and/or EQ) di-
rectly while you are recording. This is done by adding insert effects
and/or making EQ settings for the input channel in the mixer. Note:

* This will make the effects become part of the audio file itself - you can-
not change the effect settings after recording.

About the record format

When you record with effects you should consider setting the record
format (bit depth) to 32 Bit Float. This is done in the Project Setup di-
alog on the Project menu. Note that this isn't required in any way —
you can record with effects in 24 or 16 Bit format should you so like.
However, there are two advantages to 32 Bit Float format:

¢ With 32 Bit Float recording you don't risk clipping (digital distortion)
in the recorded files.
This can of course be avoided with 24 or 16 Bit recording as well, but requires more
care with the levels.

¢ Cubase SX processes audio internally in 32 Bit Float format — record-
ing in the same format means the audio quality will be kept absolutely
pristine.
The reason is that the effect processing in the input channel (as well as any level or EQ
settings you make there) is done in 32 Bit Float format. If you record at 16 or 24 Bit,
the audio will be converted to this lower resolution when it's written to file — with pos-
sible signal degradation as a result.

Note also that it doesn’t matter at which actual resolution your audio

hardware works. Even if the signal from the audio hardware is in 16 Bit
resolution, the signal will be 32 Bit Float after the effects are added in
the input channel.
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An example

This example shows how to apply the “Datube” effect while recording.
Datube emulates the soft clipping distortion produced by valve ampli-
fiers, and adds “warmth” to the recording. Note that this is only an ex-
ample, you could use any effect (or any combination of effects), the
principle is the same.

1. Set up an audio track for recording and select the desired input bus.
Also, for best results you should activate monitoring as this allows you to hear and try
out your settings before actually recording. See page 50 for a description of monitor-
ing via Cubase SX.

2. Open the Mixer and make sure the full extended view is shown.

Click here to show the
extended panel.

3. Locate the input channel (bus) from which you record.
If the input channels are hidden, click on the Show/Hide Input Channels button to the left.

=)

ik

4. Check the input level (of the signal coming into the audio hardware)
as described on page 47 and adjust the level of the source audio if
necessary.
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5. Pull down the View Options pop-up menu for the input channel and
select “Inserts”.

Empty

e

o v .EQs

| EQs +
EQs Curve
Surround Pan
WL Meter
Cwverview
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The View Options pop-up menu is opened by clicking the arrow button between the
fader panel and the extended panel.

Now the extended panel for the input channel shows the insert slots.

6. Click on an insert slot and select an effect from the pop-up menu that
appears.
As you see, the included effects are sorted into submenus — you will find the Datube
effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is automatically
opened.
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7. Adjust the Drive (the pre-gain of the “amplifier” — higher settings will
produce more distortion) and Balance (controls the balance between
the unprocessed (dry) signal and the effect output) parameters to your
liking.

8. When the effect is set up as desired, you can check the level of the in-
put channel by setting the VU Meters to post-fader (see page 48).
Use the input channel fader to adjust the level if needed.

9. Activate recording.

10.When you're finished you can play back the recorded audio track.
As you can hear, the effect you applied is now a part of the actual audio file.

11.1f you don’t want to record more with the same plug-in, you should de-
activate it by clicking in the insert slot and selecting “No Effect”.
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MIDI Recording Specifics

Activating MIDI Thru

As described in the Getting Started book, the normal way to work with
MIDI is to have MIDI Thru activated in Cubase SX/SL, and Local Off
selected in your MIDI Instrument(s). In this mode, everything you play
during recording will be “echoed” back out again on the MIDI output
and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in the Preferences
dialog (MIDI page).

2. Record enable the track(s) on which you want to record.
Now, incoming MIDI is “echoed” back out again, for all record enabled MIDI tracks.

.

* If you just want to use the Thru function for a MIDI track without record-
ing, activate the monitor button for the track instead.
This is useful e.g. if you want to try out different sounds or play a VST instrument in real
time without recording your playing.

Record Enable button. Monitor button.
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Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each
on a different MIDI channel. This is the key to playing back several
sounds (bass, piano etc.) from the same instrument. Some devices
(such as General MIDI compatible sound modules) always receive on
all 16 MIDI channels. If you have such an instrument, there’s no specific
setting you need to make in the instrument. On other instruments you
will have to use the front panel controls to set up a number of “Parts”,
“Timbres” or similar so that they receive on one MIDI channel each.
See the manual that came with your instrument for more information.

Naming MIDI ports in Cubase SX/SL

MIDI inputs and outputs can often be shown with unnecessarily long
and complicated names. If you wish, you can rename your MIDI ports
to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the Windows MIDI or DirectMusic (Win) or MIDI System (Mac)
device in the Device list.
The available MIDI inputs and outputs are listed on the Setup tab. Under Windows,
which device to choose depends on your system.

3. To change the name of a MIDI port, click in the Device column and
type in a new name.
After closing the dialog, the new names will appear on the MIDI “in:" and “out:"” pop-ups.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector — the area to the left
of the Track list in the Project window:

1. If the Inspector is hidden, click the Show Inspector button on the tool-
bar.

=y a
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. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector
shows the settings for the first selected track (for details, see page 88).

. Click the icon in the upper right corner of the Inspector to make sure
the topmost section is shown.

. Pull down the “in” pop-up menu and select an input.
The available MIDI inputs are shown. The items on the menu depend on the type of
MIDI interface you are using etc.

i e AlKIDT Ingputs -
: MPU-401

MPU-401
Delka 1010°IDI [Emulerat]

v Al MIDI Inputs

If you select the “All MIDI Inputs” option, the track will receive MIDI
data from all available MIDI inputs.

If you hold down [Alt]/[Option] and select a MIDI input, this is selected
for all MIDI tracks.

If you hold down [Shift] and select a MIDI input, this is selected for all
selected MIDI tracks.

If you hold down [Ctrl]/[Command] and select a MIDI input, this is se-
lected for all MIDI tracks within the same folder track (see page 91).
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Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded
MIDI is routed during playback, but are also relevant for MIDI Thru in
Cubase SX/SL. Channel and output can be selected in the Track list
or in the Inspector. The procedure below describes how to make the
settings in the Inspector, but it can be done in largely the same man-
ner in the Track list as well.

1. To select the track(s) and show the settings in the Inspector, proceed
as when selecting a MIDI input (see above).

2. Pull down the “out:” pop-up menu and select an output.
The available MIDI outputs are shown. The items on the menu depend on what type of
MIDI interface you are using etc.

in = AlMIDI Inputs -
ouk = Delta 1010 MIDI [Emules

Mot Connected

MPU-401
Microsoft 1 Mapper

Micrasoft G5 Wavekable SW Swnth
v Delka 1010 MIDI

* If you hold down [Alt]/[Option] and select a MIDI output, this is se-
lected for all MIDI tracks.

* If you hold down [Shift] and select a MIDI output, this is selected for
all selected MIDI tracks.

* If you hold down [Ctrl]/[Command] and select a MIDI output, this is
selected for all MIDI tracks within the same folder track (see page 91).

3. Use the “chn” pop-up menu to select a MIDI channel for the track.

in: MPU-401

Track Parameters
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* |fyou set the track to MIDI channel “Any”, each MIDI event on the track
will be sent out on the channel stored in the event itself.
In other words, the MIDI material will be played back on the channel(s) used by the
MIDI input device (the MIDI instrument you play during recording).

Selecting a sound

You can select sounds from within Cubase SX/SL, by instructing the
program to send Program Change and Bank Select messages to your
MIDI device. This is done using the “prg” and “bnk” value fields in the
Inspector or Track list.

ey Rjuwje == )1 E
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map: Mo Drum kap

Program Change messages give access to 128 different program loca-
tions. If your MIDI instruments have more than 128 programs, Bank Se-
lect messages (set in the “bnk” value field) allow you to select different
banks, each containing 128 programs.

¢ Bank Select messages are recognized differently by different MIDI instru-
ments. Also, the structure and numbering of banks and programs may
vary. Consult the documentation of your MIDI instruments for details.

¢ Note that it is also possible to select sounds by name. For descriptions
of how to set this up, see page 446.
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Recording

Recording MIDI is done according to the basic recording methods
(see page 39). When you finish recording, a part containing MIDI
events is created in the Project window.

About overlap and the Rec Mode setting

MIDI tracks are different from audio tracks when it comes to overlap-
ping parts:

* All events in overlapping parts are always played back.
If you record several parts at the same locations (or move parts so that they overlap),
you will hear the events in all parts on playback, even though some of the parts are ob-
scured in the Project window.

When recording overlapping parts, the result depends on the Rec
Mode setting on the Transport panel:

* If Rec Mode is set to “Normal”, overdub recording works as with audio tracks,
i.e. if you record again where something has already been recorded, you get a
new part that overlaps the previous one(s).

* If Rec Mode is set to “Merge”, the overdubbed events are added to the exist-
ing part.

* If Rec Mode is set to “Replace”, the new recording replaces any existing
events in the area on that track.

About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch in/out record-
ing for MIDI tracks is done in exactly the same way as for audio tracks.
There is one thing to note, however:

* Punching in and out on recordings with Pitch Bend or controller data
(modulation wheel, sustain pedal, volume etc.) may lead to strange ef-
fects (apparently hanging notes, constant vibrato etc.).

If this happens, you may need to use the Reset item on the MIDI menu (see page 74).

About the Auto Quantize function

If Auto Quantize is activated on the Transport panel (the “Auto Q" but-
ton), the notes you record are automatically quantized according to
the current Quantize settings. For more information about quantizing,
see page 505.
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Recording MIDI in cycle mode

When you record MIDI in cycle mode, the result depends on which
Cycle Record mode is selected on the Transport panel:

Cycle Rec mode: Mix (MIDI)

For each completed lap, everything you record is added to what was
previously recorded, in the same part. This is useful for building up
rhythm patterns, for example. Record a hi-hat part on the first lap, the
bass drum part on the second lap etc.

Cycle Rec mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI message) all MIDI
you have recorded on previous laps is overwritten — from that point on
in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take wasn't good enough — you start directly with a new take
on the next cycle lap and overwrite the first take.

3. After recording the second take you let the recording roll on and lis-
ten, without playing anything.
You find that the take was good up until bar seven, for example.

4. On the next lap, you wait until bar seven and start playing.
This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins — otherwise
you will overwrite the entire take.

Cycle Rec mode: Keep Last

Each completed lap replaces the previously recorded lap. Note:

¢ The cycle lap must be completed — if you deactivate recording or press
Stop before the cursor reaches the right locator, the previous take will
be kept.

¢ If you don't play or input any MIDI during a lap, nothing happens (the
previous take will be kept).
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Cycle Rec mode: Stacked
In this mode, the following happens:

* Each recorded cycle lap is turned into a separate MIDI part.

* The track is divided into “lanes”, one for each cycle lap.

* The parts are stacked above each other, each on a different lane.
» All takes but the last one are muted.
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This makes it easy to create a “perfect take” by combining the best
parts from the different cycle laps. You can edit the parts in the
Project window (by cutting, resizing and deleting) or you can use a
MIDI editor as in the following example:

1. Unmute the muted takes by clicking the parts with the Mute tool.
2. Select all takes (parts) and open them in the Key Editor for example.

3. Use the part list pop-up menu on the toolbar to select which part to
edit.
See page 528.

4. Remove or edit notes as desired.
5. When you are happy with the result, close the editor.

6. Toturn it all into a single MIDI part (containing your “perfect take”), se-
lect all parts and select Merge MIDI in Loop from the MIDI menu.

7. In the dialog that appears, activate the Erase Destination option and
click OK.

The remaining events in the parts are merged together into a single part.
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Recording different types of MIDI messages

3 You can decide exactly which event types should be recorded by using
the MIDI filters — see page 77.

Notes

With MIDI, when you press and release a key on your synth or other
MIDI keyboard, a Note On (key down) and a Note Off (key up) mes-
sage are sent out. The MIDI note message also contains the informa-
tion which MIDI channel was used. Normally, this information is over-
ridden by the MIDI channel setting for the track, but if you set the track
to MIDI channel “Any”, the notes will be played back on their original
channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation wheel, sustain
pedal, volume etc.) are considered as MIDI continuous events (as op-
posed to the momentary key down and key up messages). If you move
the Pitch bend wheel on your synthesizer while recording, this move-
ment is recorded together with the key (Note On and Note Off mes-
sages), just as you'd expect. But the continuous messages can also
be recorded after the notes have been recorded (or even before). They
can also be recorded on their own tracks, separately from the notes to
which they belong.

Say for instance that you record one or several bass parts on track 2.
If you now set another track, like track 55, to the same output and
MIDI channel as track 2 you can make a separate recording of just
pitch bends for the bass parts. This means that you activate recording
as usual and only move the pitch bend wheel during the take. As long
as the two tracks are set to the same output and MIDI channel it will
appear to the MIDI instrument as if the two recordings were made at
the same time.
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Program Change messages

Normally, when you switch from one program to another on your key-
board (or whatever you use to record), a number corresponding to that
program is sent out via MIDI as a Program Change message. These
can be recorded on the fly with the music, recorded afterwards on a
separate track, or manually entered in the Key or List Editors.

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI message used to
send data that only makes sense to a unit of a certain make and type.
Every major MIDI manufacturer has its own SysEx identity code and
these are part of practically all SysEx messages. SysEx can be used to
transmit a list of the numbers that make up the settings of one or more
sounds in a synth. For more about viewing and editing SysEx mes-
sages, see the chapter “Working with System Exclusive messages”.

The Reset function

The Reset function on the MIDI menu sends out note-off messages
and resets controllers on all MIDI channels. This is sometimes neces-
sary if you experience hanging notes, constant vibrato, etc.

* Cubase SX/SL can also automatically perform a MIDI reset during
playback (after each part) and/or on stop.
You turn these functions on or off in the Preferences dialog (MIDI page).
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Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop
mode or during playback and turn them into a MIDI part “after the fact”.
This is possible due to the fact that Cubase SX/SL can capture MIDI
input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the Retrospective Record function in the Preferences dialog
(Record page).
This activates the buffering of MIDI input, making Retrospective Record possible.

2. Make sure a MIDI track is record enabled.

3. When you have played some MIDI material you want to capture (either
in Stop mode or during playback), select Retrospective Record from
the Transport menu (or use the key command, by default [Shift]-[Pad*]).

The contents of the MIDI buffer (i.e. what you just played) is turned into
a MIDI part on the record enabled track. The part will appear where the
project cursor was when you started playing — this means that if you
played along during playback, the captured notes will end up exactly
where you played them in relation to the project.

* The Retrospective Record Buffer Size setting in the Preferences dia-
log (Record page) determines how much data can be captured.
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MIDI Preferences

The following options and settings in the Preferences dialog affect
MIDI recording and playback:

MIDI page

* Length Adjustment
Adjusts the length of notes so that there always is a short time between the end of one
note and the start of another (of the same pitch and on the same MIDI channel). You
set the time in ticks. By default there are 120 ticks per 1/16 note, but you can adjust
this with the MIDI Display Resolution setting on the same page.

Record page

* Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be lengthened to start
and end at whole bar positions. If you are working in a Bars+Beats-based context, this
can make editing (moving, duplicating, repeating, etc.) easier.

* Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track is automati-
cally record enabled. Furthermore, Record Enable is deactivated for all other MIDI
tracks until you close the editor again.
This makes it easier to record MIDI data when you're editing a part — you will always be
sure the recorded data ends up in the edited part and not on any other track.

* MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make sure the very
start of the recording is included. A very annoying scenario is when you have recorded
a perfect MIDI take, only to find out that the very first note wasn't included — because
you started playing a little bit too early! If you raise the Record Catch Range, Cubase
SX/SL will catch the events played just before the recording start point, eliminating this
problem.
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Filtering MIDI
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The MIDI-MIDI Filter page in the Preferences dialog allows you to
prevent certain MIDI messages from being recorded and/or “thruput”
(echoed by the MIDI Thru function).

The dialog is divided into four sections:

Section Description

Record Activating any of these options prevents that type of MIDI message from
being recorded. It will, however, be thruput, and if already recorded, it
will play back normally.

Thru Activating any of these options prevents that type of MIDI message from
being thruput. It will, however, be recorded and played back normally.

Channels If you activate a channel button, no MIDI messages on that MIDI channel
will be recorded or thruput. Already recorded messages will, however,
be played back normally.

Controller Allows you to prevent certain MIDI controller types from being recorded
or thruput.
To filter out a controller type, select it from the list at the top of the
Controller section and click “Add". It will appear on the list below.
To remove a controller type from the list (allow it to be recorded and
thruput), select it in the lower list and click “Remove”.
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Options and Settings

Recording-related Preferences

A couple of settings in the Preferences dialog (Transport page) are
relevant for recording. Set these according to your preferred method
of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically de-
activated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after automatic
punch out (when the project cursor reaches the right locator and
punch out is activated on the Transport panel). If the postroll value on
the Transport panel is set to a value other than zero, playback will con-
tinue for the set time before stopping (see below).
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About Preroll and Postroll

Preroll value field and on/off switch.

13.01.01.00( Postroll value field and on/off switch.

Co B

The preroll and postroll value fields (below the left/right locator fields)
on the Transport panel have the following functionality:

* By setting a preroll value, you instruct Cubase SX/SL to “roll back” a short
section whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant when recording
from the left locator (punch in activated on the Transport panel) as described below.

* By setting a postroll value, you instruct Cubase SX/SL to play back a short
section after automatic punch out, before stopping.
This is only relevant when punch out is activated on the Transport panel and “Stop
after Automatic Punchout” is activated in the Preferences dialog (Transport page).

* To turn pre- or postroll on or off, click the corresponding button on the Trans-
port panel (next to the pre/postroll value) or use the “Use Preroll” and “Use
Postroll" options on the Transport menu.

An example:
1. Set the locators to where you want to start and end recording.
2. Activate punch in and punch out on the Transport panel.

3. Activate the option “Stop after Automatic Punchout” in the Preferences
dialog (Transport page).

4. Set suitable preroll and postroll times by clicking in the corresponding
fields on the Transport panel and typing in time values.

5. Activate pre- and postroll by clicking the buttons next to the preroll
and postroll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field and playback
starts. When the cursor reaches the left locator, recording is automatically activated.
When the cursor reaches the right locator, recording is deactivated, but playback con-
tinues for the time set in the postroll field before stopping.
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Using the metronome

The metronome will output a click that can be used as a timing refer-
ence. The two parameters that govern the timing of the metronome are
tempo and time signature, and these are edited in the Tempo Track
window (see page 640).

You can use the metronome for a click during recording and/or play-
back or for a precount (count-in) that will be heard when you start re-
cording from Stop mode. Click and precount are activated separately:

* To activate the metronome, click the Click button on the Transport panel.
You can also select “Metronome On" from the Transport menu or use the correspond-
ing key command (by default [C]).

* To activate the precount, click the Precount button on the Transport panel.
You can also select “Precount On” from the Transport menu or set up a key command

for this.
g IER,
Click on/off |y 12']_‘}]-"3 Precount on/off
SHYHC IMT. |
Metronome settings

You make settings for the metronome in the Metronome Setup dialog,
opened from the Transport menu.

> Metronome Setup

(o it Click during

Mot Connected «| MIDI Dutput Record
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B Lo ot

= Precount Options
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Audio Click ﬁ Precount Bars
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The metronome can use either an audio click played back via the au-
dio hardware, send MIDI data to a connected device which will play
back the click or do both.
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The following metronome settings can be made in the dialog:

Parameter Description

MIDI Click on/off Selects whether or not the metronome will sound via MIDI.

MIDI Output Use the pop-up to select a MIDI output for the metronome click.

Channel Selects the MIDI channel for the metronome click.

High Note Sets the MIDI note number for the “high note” (the first beat in a
bar).

High Velocity Sets the velocity value for the “high note” (the first beat in a bar).

Low Note Sets the MIDI note number for the “low note” (the other beats).

Low Velocity Sets the velocity value for the “low note” (the other beats).

Audio Click on/off  Selects whether or not the metronome will sound via the audio
hardware.

Audio Click Volume Adjusts the volume for the audio click.
slider

Click during Allows you to specify whether the metronome should be heard
during playback, recording or both (when Click is activated on the
Transport panel).

Use Count Base If this option is activated, you use the field to the right to specify
the “rhythm” of the metronome. Normally, the metronome plays
one click per beat, but setting this to e.g. “1/8" gives you eighth
notes — two clicks per quarter note beat. It's also possible to cre-
ate unusual metronome rhythms such as triplets etc.

Precount Bars Sets the number of bars the metronome will count in before it
starts recording if precount is activated on the Transport panel.

From Tempo Track  When this is activated, the precount will be in the time signature
set in the Tempo track. Furthermore, any tempo changes in the
Tempo track during the precount will be applied.

Use Signature If “From Tempo Track” is deactivated, you can use these fields to
set a time signature for the precount. In this mode, tempo changes
in the Tempo track won't affect the precount.
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9

The Project window



Background

The Project window is the main window in Cubase SX/SL. This pro-
vides you with an overview of the project, allowing you to navigate and
perform large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline run-
ning horizontally from left to right. The following track types are avail-

able:

Track type
Audio

Folder

FX Channel

Group
Channel

MIDI

Description

For recording and playing back audio events and audio parts. Each au-
dio track has a corresponding audio channel in the mixer.

An audio track can have any number of automation “subtracks” for auto-
mating mixer channel parameters, insert effect settings etc.

Folder tracks function as containers for other tracks, making it easier to
organize and manage the track structure. They also allow you to edit sev-
eral tracks at the same time. See page 145.

FX channel tracks are used for adding send effects. Each FX channel can
contain up to eight effect processors — by routing effect sends from an
audio channel to an FX channel, you send audio from the audio channel
to the effect(s) on the FX channel. Each FX channel has a corresponding
channel strip in the mixer — in essence an effect return channel. See page
244 for more about FX Channel tracks and send effects.

An FX channel can also have any number of automation subtracks for au-
tomating mixer channel parameters, effect settings etc. All FX channel
tracks are automatically placed in a special FX channel folder in the Track
list, for easy management.

By routing several audio channels to a Group channel, you can submix
them, apply the same effects to them, etc. (see page 222).

A Group channel track contains no events as such, but displays settings
and automation curves for the corresponding Group channel. Each Group
channel track has a corresponding channel strip in the mixer. In the Project
window, Group channels are organized as subtracks in a special Group
Tracks folder.

For recording and playing back MIDI parts. Each MIDI track has a corre-
sponding MIDI channel strip in the mixer.

A MIDI track can have any number of automation “subtracks” for auto-
mating mixer channel parameters, insert and send effect settings etc.
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Track type Description

Marker The Marker track displays markers, and allows you to move and rename
them directly in the Project window (see page 158). There can only be
one Marker track in the project.

Ruler Ruler tracks contain additional rulers, displaying the timeline from left to

(SX only) right. In Cubase SX you can use any number of ruler tracks, each with a
different display format if you wish. See page 96 for more information
about the ruler and the display formats.

Video For playing back video events. A project can only have one Video track.

About parts and events

Events are the basic building blocks in Cubase SX/SL. Different event
types are handled differently in the Project window:

* Video events and automation events (curve points) are always viewed and re-
arranged directly in the Project window.

* MIDI events are always gathered in MIDI parts, containers for one or more
MIDI events. MIDI parts are rearranged and manipulated in the Project win-
dow. To edit the individual MIDI events in a part, you have to open the part in
a MIDI editor (see page 526).

* Audio events can be displayed and edited directly in the Project window, but
you can also work with audio parts containing several events. This is useful if
you have a number of events which you want to treat as one unit in the project.

e T

An audio event and an audio part.
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Window Overview

The info line. Project overview The toolbar. The ruler.
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The Inspector.

Track list with various

track types.
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The Track list

The Track list is the area to the left in the Project window. It contains
name fields and various settings for the tracks. Different track types
have different controls in the Track list. To see all the controls you may
have to resize the track in the Track list (see page 103):

¢ The Track list area for an audio track:

Track name Monitoring on/off

Mute & Solo Record Enable Automation Read/

Write buttons

Output activity

Show/hide indicator

automation

Edit channel settings Lock track button

Indicates whether effect sends, EQ or insert Musical/Linear time

effects are activated for the track. Click to bypass. base (see page 113)

* The Track list area for an automation subtrack (revealed by clicking
the + button on a track):

Expand automation track
(show more parameters) Automation Read/Write buttons

=000

Mute ~ Lock track button ~ Automation parameter
(click to select parameter)

e The Track list area for a MIDI track:

Record Enable

Track name

Indicates whether effect sends or insert effects
are activated for the track. Click to bypass.

Edit channel settings

Monitoring on/off
Lock track

'mlar-mm 0)0 EIEIBEE 7))

out : Mic

Drum map assign

MIDI Output Automation Read/~” Bank

Mute & Solo Write buttons Output activity

indicator
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The Inspector

The area to the left of the Track list is called the Inspector. This shows
additional controls and parameters for the track you have selected in
the Track list. If several tracks are selected (see page 109), the In-
spector shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in the toolbar.

0 =

Audio 04 G -
The Inspector icon.

* For most track classes, the Inspector is divided into a number of sec-
tions, each containing different controls for the track. You can hide or
show sections by clicking the tabs in their top right corner.

Clicking the tab for a hidden section brings it to view and hides the other sections.
[Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affect-
ing other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in
the Inspector.

MIDI 01

* Folding a section does not affect the functionality but merely hides the
section from view.
In other words, if you have set up a track parameter or activated an effect for example,
your settings will still be active even if you fold the Inspector section.

Which sections are available in the Inspector depends on the selected
track’s class.
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Sections

Motepad

In general, the Inspector contains the same controls as the Track list,
but there are also some additional buttons and parameters. Below is a
list of all common, possible settings and sections, their controls and
usage, followed by descriptions of which sections are actually avail-
able for each type of track:

Parameter

Auto Fades
Settings button
Edit button

Volume

Pan

Delay

Description

Opens a dialog in which you can make separate Auto Fade settings
for the track. See page 180.

Opens the Channel Settings window for the track, allowing you to
view and adjust effect and EQ settings, etc. See page 212.

Use this to adjust the level for the track. Changing this setting will
move the track’s fader in the mixer window, and vice versa. See page
202 to learn more about setting levels.

Use this to adjust the panning of the track. As with the Volume set-
ting, this corresponds to the Pan setting in the mixer.

This adjusts the playback timing of the audio track. Positive values
delay the playback while negative values cause the track to play ear-
lier. The values are set in milliseconds.

This lets you specify which Input bus or MIDI input the track should
use (see page 14 for information about Input busses).
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Parameter Description

Out Here you decide to which output the track should be routed. For audio
tracks you select an output bus (see page 14) or Group channel, for
MIDI tracks you select a MIDI output.

Inserts section  Allows you to add insert effects to the track, see page 234. The Edit
button at the top of the section opens the control panels for the
added insert effects.

Equalizers Lets you adjust the EQs for the track. You can have up to four bands
section of EQ for each track, see page 214. The Edit button at the top of the
section opens the Channel Settings window for the track.

Equalizer Curve Lets you adjust the EQs for the track graphically, by clicking and
section dragging points in a curve display.

Sends section  Allows you to route an audio track to one or several FX channels (up
to eight), see page 244. For MIDI tracks, this is where you assign
MIDI send effects. The Edit button at the top of the section opens the
control panel for the first effect in each FX channel.

Channel section Shows a duplicate of the corresponding mixer channel strip. The
channel overview strip to the left lets you activate and deactivate
insert effects, EQs and sends.

Notepad section This is a standard text notepad, allowing you to jot down notes about
the track.

Audio tracks

For audio tracks, all settings and sections listed above are available.

MIDI tracks

When a MIDI track is selected, the Inspector contains a number of ad-
ditional sections and parameters, affecting the MIDI events in real time
(e.g. on playback). Which sections are available for MIDI tracks is de-
scribed in a separate chapter, see page 459.

Marker tracks

When the marker track is selected, the Inspector shows the marker
list. See page 154.

Video tracks
When a Video track is selected, the Inspector shows the Notepad
section only.
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Folder tracks

When a folder track is selected, the Inspector shows the folder and its
underlying tracks, much like a folder structure in the Windows Explorer
or Mac OS X Finder.

¢ You can click one of the tracks shown under the folder in the Inspector
to have the Inspector show the settings for that track.
This way, you don't have to “open” a folder track to make settings for tracks within it.

Folder

Folder
e e Buiclio 03

“
“*

Audio 05
- i Audio 06

FFles—— |

Audio 04

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following controls and sec-
tions are available:

* Edit button.

* Volume control.

* Pan control.

»  Output routing pop-up menu.
* Inserts section.

+ Equalizers section.

* Channel section.

* Notepad section.
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FX channel folder tracks

FX channel tracks are automatically placed in a special folder, for easier
management. When this folder track is selected, the Inspector shows
the folder and the FX channels it contains. You can click one of the FX
channels shown in the folder to have the Inspector show the settings
for that FX channel — this way you don't have to “open” a folder track to
access the settings for the FX channels in it.

Group channel tracks

When a Group channel track is selected, the following controls and
sections are available:

* Edit button.

*  Volume control.

* Pan control.

*  Output routing pop-up menu.
* Inserts section.

* Equalizers section.

* Sends section.

¢+ Channel section.

* Notepad section.

Group channel folder tracks

Just like FX channel tracks, all Group channel tracks are placed in a
separate folder — when this is selected, the Inspector shows the folder
and the Group channels it contains. You can click one of the Group
channels shown in the folder to have the Inspector show the settings
for that Group channel — this way, you don't have to “open” a folder
track to access the settings for the Group channels in it.

Ruler tracks (Cubase SX only)

For ruler tracks, the Inspector isn't used.
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The toolbar

The toolbar contains tools and shortcuts for opening other windows
and various project settings and functions:

Constrain delay compen- Open Pool
sation (see page 270)\‘ Showr/hide info line Automation mode (Cubase SX only)

|

Show/hide Open Mixer
Inspector  Show/hide Overview

Active project
indicator

Project window tools
A

% A X

Transport controls
(Previous/Next Marker, Cycle, Stop, Play, and Record)

Sinap on/off Griij pop-up menu Color pop-up menu

Autoscroll on/off ~ Snap mode Quantize value

¢ |In addition, the toolbar can contain a number of other tools and short-
cuts, not visible by default. How to set up the toolbar and specify which
tools should be displayed or hidden is described on page 792.
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The info line

Facle In
7 444

End Qffset
00:01:46.101 0.000

The info line shows information about the currently selected event or
part in the Project window. You can edit almost all values in the info
line using regular value editing. Length and position values are dis-
played in the format currently selected for the ruler (see page 96).

¢ To hide or show the info line, click this icon on the toolbar:

The following elements can be selected for display and editing on the
info line:

e Audio events.
* Audio parts.

* MIDI parts.
* Video events.
e Markers.

*  Automation curve points.

When several elements are selected

* If you have several elements selected, the info line will show information about
the first item in the selection. The values will be shown in yellow to indicate
that several elements are selected.

* If you edit a value on the info line, the value change is applied to all selected
elements, relatively to the current values.

An example: You have two audio events selected. The first is one bar
long and the other two bars long. The info line shows the length of the
first event (one bar). If you now edit this value to 3 bars in the info line,
the other event will be resized by the same amount — and will thus be
4 bars long.

* If you press [Cirl]/[Command] and edit on the info line, the values will be abso-
lute instead. In our example above, both events would be resized to 3 bars. Note
that [Ctrl]/[Command] is the default modifier key for this — you can change this
in the Preferences dialog (Editing-Tool Modifiers page, under the Info Line cate-

gory).
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Editing Transpose and Velocity for MIDI parts

When one or several MIDI parts are selected, the info line contains
Transpose and Velocity fields.

* Adjusting the Transpose field transposes the selected parts in semi-
tone steps.
Note that this transposition doesn't change the actual notes in the part — it's just a
“play parameter”, affecting the notes on playback. The transposition you specify for a
part on the info line is added to the transposition set for the whole track with the Trans-
pose track parameter in the Inspector (see page 464).

* Adjusting the Velocity field shifts the velocity for the selected parts —
the value you specify is added to the velocities of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again, the value you

specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector
(see page 464).

CUBASE SX/SL
The Project window | 5 - 95



The ruler

The ruler at the top of the event display shows the timeline. Initially, the
Project window ruler uses the display format specified in the Project
Setup dialog (see page 99), as do all other rulers and position dis-
plays in the project. However, you can select an independent display
format for the ruler by clicking the arrow button to the right of it and
selecting an option from the pop-up menu that appears (you can also
bring up this pop-up menu by right-clicking (Win) or [Cirl]-clicking
(Mac) anywhere in the ruler).

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. By default there are 120
ticks per sixteenth note but you can adjust this with the “MIDI Dis-
play Resolution” setting in the Preferences dialog (MIDI page).

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds and frames. The
number of frames per second (fps) is set in the Project Setup di-
alog (see page 99). You can choose from 24, 25, 29.97 and 30
fps or 29.97 and 30 dfps (“drop frame”).

Samples Samples.

User Hours, minutes, seconds and frames, with a user definable num-
ber of frames per second. You set the desired number of fps in
the Preferences dialog (Transport page).

* The selection you make here affects the ruler, the info line and tool tip
position values (appear when you drag an event in the Project window).
You can also select independent formats for other rulers and position displays.

* To set the display format globally (for all windows), use the primary dis-
play format pop-up on the Transport panel, or hold down [Ctrl]/[Com-
mand] and select a display format in any ruler.

* If you use the “Timecode” or “User” options and the option “Show
Timecode Subframes” is activated in the Preferences dialog (Trans-
port page), the frames will also display subframes.

There are 80 subframes per frame.
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Using multiple rulers - ruler tracks (Cubase SX only)

As described above, the Cubase SX/SL Project window contains a
main ruler at the top of the event display, displaying the timeline from
left to right.

If needed, you can have several rulers in the Project window, by add-
ing ruler tracks to the project. Each ruler track contains an additional
ruler.

* To add a ruler track, select “Add Track” from the Project menu and
from the submenu that appears, select “Ruler”.
A ruler track showing an additional ruler is added to the Track list.

0 I1
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Stereo ‘ L E) w
A ruler track set to the display format “Seconds”.
You can add any number of ruler tracks to a project, and position them

as needed by dragging them up or down in the list. Each one can
show a separate display format:

* To select a display format for a ruler track, click the leftmost part of it
in the track list and select an option from the pop-up menu.
See the section “The ruler” above for descriptions of the different display formats.

Bars+j§ts
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Timecods
Samples
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Note that ruler tracks are completely independent from the main event
display ruler, as well as rulers and position displays in other windows.
This means that:

* Ruler tracks can all have independent display formats.

* Ruler tracks are not affected by the display format setting in the Project Setup
dialog (see page 99).

* Ruler tracks are not affected if you set the display format globally with the pri-
mary time display in the Transport panel.

* Ruler tracks are however affected by the option “Show Timecode Sub-
frames” (described above) in the Preferences dialog.
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Operations

Creating a new project

You create a new project in the following way:

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any custom templates
you may have created (see page 763).

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will
contain all files related to the project.

3. Select an existing folder or type the name of a new one. Click OK.
A Project window appears. The new project will be based on the selected template,
and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project Setup dialog.
This is opened by selecting “Project Setup...” from the Project menu.

LC Project Setup

I s

m Dizplay Offset
I - o

m Sterea Pan Law
Hep | oK |

Cancel

The Project window
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The following settings are available in the Project Setup dialog:

Setting

Start

Length

Frame Rate

Display Format

Display Offset

Bar Offset

Sample Rate

Record Format

Record File Type

Stereo Pan Law

Description

The start time of the project. Allows you to have the project start at an-
other time than zero. Also used for setting the sync start position when
synchronizing Cubase SX/SL to external devices (see page 715).

The length of the project.

Used if you are synchronizing Cubase SX/SL with external equipment. If
Cubase SX/SL is the slave, this value is automatically set to the frame
rate of the incoming sync signal. If Cubase SX/SL is the master, this de-
termines the frame rate of the sent sync signal. See page 721.

This is the global display format used for all rulers and position dis-

plays in the program, except ruler tracks (Cubase SX only, see page
92). However, you can make independent display format selections
for the individual rulers and displays if you like.

For descriptions of the different display format options, see page 96.

Offsets the time positions displayed in the ruler etc., allowing you to
compensate for the Start position setting. Typically, if you synchro-
nize Cubase SX/SL to an external source starting at a frame other
than zero, you set the Start position to this value. However, if you still
want the display in Cubase SX/SL to start at zero, set the Display
Offset to the same value too.

This works just like “Display Offset” described above, in that it off-
sets the time positions in the ruler by a number of bars, allowing you
to compensate for the Start position setting. The difference is that
Bar Offset is only used when the “Bars+Beats” display format is se-
lected (see page 96).

The sample rate at which Cubase SX/SL records and plays audio.

When you record audio files in Cubase SX/SL, they are recorded
with this resolution. See page 43.

The file type that should be created when you record audio. See
page 43.

Decides whether panning should use power compensation or not.
This is explained on page 209.

0 While most settings in the Project Setup can be changed at any time, you
should select a sample rate once and for all when starting with a new
project! All audio files must be of this sample rate to play back correctly.
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Zoom and view options

Zooming in the Project window is done according to the standard
zoom procedures (see the Getting Started book), with the following

special notes:

When you are using the Zoom tool (magnifying glass), the result de-

pends on the option “Zoom Tool Standard Mode: Horizontal Zooming
Only” in the Preferences — Editing dialog.

If this is activated and you drag a selection rectangle with the Zoom tool, the window
will only be zoomed horizontally (track height will not change). If the option is off, the

window will be zoomed both horizontally and vertically.

When using the vertical zoom sliders, the tracks are scaled relatively.
In other words, if you have made any individual track height adjustments (see below),
the relative height differences are maintained.

You find the following options are available on the Zoom submenu on

the Edit menu:

Option
Zoom In
Zoom Out

Zoom Full

Zoom to Selection

Zoom to Selection
(Horiz)

Zoom to Event
Zoom In Vertical
Zoom Out Vertical
Zoom In Tracks
Zoom Out Tracks

Zoom Selected
Tracks

Description
Zooms in one step, centering on the project cursor.
Zooms out one step, centering on the project cursor.

Zooms out so that the whole project is visible. “The whole project”
means the timeline from the project start to the length set in the
Project Setup dialog (see above).

Zooms in horizontally and vertically so that the current selection
fills the screen.

Zooms in horizontally so that the current selection fills the screen.

This option is available only in the Sample Editor (see page 371).
Zooms in one step vertically.

Zooms out one step vertically.

Zooms in selected track(s) one step vertically.

Zooms out selected track(s) one step vertically.

This zooms in vertically on the selected track(s) and minimizes the
height of all other tracks.
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* If the option “Zoom while Locating in Time Scale” is activated in the
Preferences (Transport page), you can also zoom by clicking in the
main ruler and dragging up or down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

*  You can zoom the contents of parts and events vertically, using the
Waveform Zoom slider in the top right corner of the event display.
This can be useful to better view quiet audio passages.

O To get an approximate reading on the level of the audio events by view-
ing the waveforms, make sure the slider is all the way down. Otherwise,
zoomed waveforms may be mistaken for clipped audio.

* If you activate the option Quick Zoom in the Preferences (Editing page),
the contents of parts and events will not be continuously redrawn when
you zoom manually.

Instead, the contents are redrawn once you have stopped changing the zoom - acti-
vate this if screen redraws are slow on your system.
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Resizing tracks in the Track list

You can change the height of an individual track by clicking on its lower bor-
der in the Track list and dragging up or down.

To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and re-
size one of the tracks in this way. If “Snap Track Heights" is activated on the Track scale
pop-up (see below), the track height will change in fixed increments when you resize it.

You can also change the width of the Track list area, by dragging the
border between the Track list and the event display.

The controls shown for tracks in the Track list will by default adapt to
the track size. This means that when resizing a track’s height or width
some of the controls will be dynamically placed where they best “fit in".
If you instead always want to have the controls in fixed positions, you can deactivate
the option “Wrap Controls” in the Track Controls settings dialog (see page 794).

You can decide for each track type what controls should be shown in the
Track list — see page 794.

You can use the Track scale pop-up (opened by clicking the arrow button
above the vertical zoom control) to set the number of tracks to view in the cur-
rent Project window.

The track height will be adjusted to show only the number of tracks specified on the
pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the
number of tracks to fit in the current Project window.

Zoom Tracks 1 Row
Zoom Tracks 2 Rows
Zoom Tracks 3 Rows
Zoom Tracks 4 Rows
Zoom Tracks N Rows
Zoom Tracks Full =
- Zoom 4 Tracks
Zoom § Tracks
Zoom M Tracks
Zoom Tracks Minimal

Snap Track Heights

| |
Pl =—a—+

2 ib[<]

Tracks can also be divided vertically in lanes — see page 132.
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Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control allows you
to select, create and organize zoom presets. These are useful if you
want to toggle between different zoom settings (e.g. one where the
whole project is displayed in the project window and another with a
high zoom factor for detailed editing). With this pop-up menu, you can
also zoom in on the area between cycle markers in the project.

Zoom Full

Zaoom to Locakars

~6 minutes 1
~1 minute
~:30 seconds
~10 seconds
~+3 seconds
~1 second

~2000 s ]
~30 ms I |EEE |EEE
~10 ms

~5 ms
~1ms

Marker 2
Marker 1
add

Crganize. ..

The upper part of the menu lists the zoom presets:

* To store the current zoom setting as a preset, select Add from the
pop-up menu.
A dialog appears, allowing you to type in a name for the preset.

* To select and apply a preset, select it from the pop-up menu.

* The “Zoom Full” preset is always available. Selecting this option Zooms
out so that the whole project is visible. “The whole project” means the
timeline from the project start to the length set in the Project Setup dia-
log (see page 99).

* If you want to delete a preset, select “Organize...” from the pop-up
menu.
In the dialog that appears, select the preset in the list and click the Delete button. The
preset is removed from the list.

CUBASE SX/SL
5 - 104 | The Project window



e If you want to rename a preset, select “Organize...” from the pop-up
menu.
In the dialog that appears, select the desired preset in the list and click the Rename
button. A second dialog opens, allowing you to type in a new name for the preset.
Click OK to close the dialogs.

O Zoom presets are global for all projects, i.e. they are available in all
projects you open or create.

The middle part of the pop-up lists any cycle markers you have added
in the project:

* If you select a cycle marker form this menu, the event display is
zoomed in to encompass the marker area (see page 161).

* You cannot edit the cycle markers in this pop-up menu. For information
on editing markers, see page 154.

a Only the cycle markers you create in the current project are available on
the menu.

The Zoom history

Cubase SX/SL maintains a history of recent zoom stages, allowing you
to undo and redo zoom operations. This way you can zoom in several
steps and then easily go back to the zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo Zoom:

* Use the items on the Zoom submenu on the Edit menu.
You can also assign key commands for these.

* Double click with the Zoom tool (magnifying glass) to Undo Zoom.
Press [Alt]/[Option] and double click to Redo Zoom.
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Adjusting how parts and events are shown

The Preferences dialog on the File menu (the Cubase SX/SL menu,
under Mac OS X) contains several settings for customizing the display
in the Project window.

The Event Display page contains common settings for all track types:

Option

Colorize Event
Background

Transparent Events

Show Data on Small
Track Heights

Show Event Names

Description

Determines whether the backgrounds or “contents” (waveforms,
etc.) of parts and events will be colorized. See page 109.

When this is activated, events and parts will be transparent,
showing the waveforms and MIDI events only.

If this is activated, the contents of events and parts will be
shown, even if the height of a track is very small.

Determines whether the names of parts and events should be
shown in the Project window.

The Event Display-Video page contains settings for video events:

Option

Show Video
Thumbnails

Video Cache Size

Description

When this is activated, thumbnail frames of the video contents
are shown on the Video track.

This determines how much memory is available for video thumb-
nails. If you have long video clips and/or work with a large zoom
factor (so that a lot of frames are shown in the thumbnails), you

may have to raise this value.
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The Event Display—Audio page contains settings for audio events:

Option

Interpolate Audio
Images

Wave Image Style

Show Event Volume
Curves Always

Description

If the option is deactivated, single sample values are drawn as
“steps”. If the option is activated they are interpolated to form
“curves”.

Determines whether audio waveforms should be displayed as
solid images, frames or “inverted” images (solid+frame). This
selection affects all waveform images in the Project window,
Sample Editor and Audio Part Editor.

Note that the “Framed” and “Solid and Framed" styles are more
demanding for the computer. If the system feels slower in these
modes, please switch back to “Solid” wave image style.

If this is activated the “volume curves” created with the volume
and fade handles are always shown - if not, the curves are only
shown for selected events.

The Event Display—MIDI page contains settings for MIDI parts:

Option

Default Edit Action

Part Data Mode

Show Controllers

Edit as Drums
when Drum Map is
assigned

Note Name Style

Description

Determines which editor should be opened when you double
click a MIDI part or select it and press [Ctrl]/[Command]-[E]: the
Key, Drum, List or Score editor. Note that this setting is overrid-
den for tracks with drum maps if the option “Edit as Drums when
Drummap is assigned” (see below) is activated.

Determines if and how events in MIDI parts should be shown in

the Project window: as lines, as score notes or as drum notes. If
“No Data” is selected, events will not be shown at all. Note that

this setting is overridden for tracks with drum maps if the option
“Edit as Drums when Drum Map is assigned” (see below) is acti-
vated.

Governs whether non-note events (controllers, etc.) should be
shown in MIDI parts in the Project window.

If this is activated, parts on MIDI tracks with drum maps assigned
will be shown with drum note symbols in the Project window.
Also, the parts will automatically open in the Drum editor when
double clicked (overriding the Default Edit Action setting above).

Determines how MIDI note names (pitches) should be displayed
in editors, etc.
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Zooming and navigating in the overview line

By clicking the Show Overview button on the toolbar, an extra pane
appears under the toolbar; the project overview line.

Show Overview button

In the overview line, events and parts on all tracks are displayed as
boxes. You can use the overview line to zoom in or out, and for navi-
gating to other sections of the project. This is done by moving and re-
sizing the track view rectangle in the overview line:
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¥ The track view rectangle

* The track view rectangle indicates the section of the project currently
displayed in the event display.

* You can zoom in or out horizontally by resizing the rectangle.
Resizing is done by dragging the edges of the rectangle.
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* You can drag the track view rectangle to view other sections of the
project.
This can also be done by clicking anywhere in the upper part of the overview — the
track view rectangle will be moved to where you clicked. The number of tracks shown
will not change.
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Handling tracks

To add a track to the project, select “Add Track” from the Project menu
and select a track type from the submenu that appears. The new track
is added below the currently selected track in the Track list.

¢ The items on the “Add Track” submenu are also available on the
Quick menu.
This is accessed by right-clicking (Win)/[Ctrl]-clicking (Mac) in the Track list.

Select All Events
Duplicate Track
Show Automation

Show Used Autornation
Remove Track

Track Controls Settings...
Disable Track.

Auto Fades Settings...
Set Record Folder

Add Audio Track

Add Fi Channel Track
Add Folder Track

Add Group Channel Track
Add MIDT Track

Add Marker Track

Add Ruler Track

Add Yideo Track

Add Multiple Tracks. ..

Remove Selected Tracks

Show Used Automnation For &l Tracks
Hide All &utornation

e There is an additional option at the bottom of the Add Track submenu,
called “Multiple...". Selecting this brings up a dialog allowing you to
add more than one track in one operation.

The number of tracks to add is entered in the “Count” value field. You can set whether
audio, MIDI or group tracks should be created by selecting from the Track pop-up in
the dialog. For audio and group tracks, the channel configuration — mono, stereo or a
surround configuration (Cubase SX only) — can be set in the Configuration pop-up.
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Once you have created tracks, you can manipulate and rearrange them
in various ways:

* To rename a track, double click in the name field and type in a new
name.
If you hold down any modifier key when pressing [Return] to close the name field, all
events on the track will get the name you entered.

¢ To select a track, click on it in the Track list.
A selected track is indicated by a light grey color in the Track list.
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This track is selected.
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It is possible to select several tracks, by pressing [Ctrl]l/[Command] and clicking them.
To select a continuous range of tracks, use [Shift]-clicking.

* To move a track, click and drag it up or down in the list.

* To duplicate a track, complete with all contents and channel settings,
right-click (Win)/[Citrl]-click (Mac) in the Track list and select “Dupli-
cate track” from the context menu.

The duplicated track will appear above the original track.

* You can colorize the contents of selected track(s), or selected parts
and events by clicking the Color button on the toolbar and selecting a
color from the pop-up menu that appears.

If one or several tracks are selected, all events and parts on the track(s) will get the se-
lected color, as will any events and parts you add to the track later. If individual events or
parts are selected, only these will be affected. Individually colorized events and/or parts
will keep the applied color even if the track they belong to is later set to another color.
The option “Colorize Event Background” in the Preferences dialog (Event Display page)
determines whether the backgrounds or waveforms of events will be colorized.

* Toremove a track, right-click (Win)/[Ctrl]-click (Mac) on it in the Track
list and select “Remove Track” from the context menu that appears.
You can also remove multiple selected tracks, by selecting “Remove Selected Tracks”
either from the Project menu or from the context menu. Furthermore, you can remove
all tracks not containing any events by selecting “Remove Empty Tracks” from the
Project menu.
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Disabling tracks

Tracks can be disabled by selecting “Disable Track” from the Track
list context menu. Disabling a track in a way is the same as Muting it
(see page 130), since a disabled track will not be played back. How-
ever, disabling a track not only “zeroes” the output volume from the
track, but actually shuts down all disk activity for it. See page 34 for
more information.

Dividing the Track list (Cubase SX only)

It is possible to divide the Track list into two parts. Both sections will
have independent zoom and scroll controls (if needed), but resizing
the window vertically will affect the lower section only (if possible).
This could be convenient for example if you're working with a video
track along with multi-track audio. This way, you can place the video
track in the upper Track list, letting you scroll the audio tracks sepa-
rately in the lower Track list, referencing them against the video track.

* To divide the Track list, click the “Divide Track List” button in the top
right corner of the Track list.
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The “Divide Track List” button.

* To revert to a single Track list, click the button again.

When the Track list is divided into two parts, the following applies:

e |f you add tracks from the Project—Add Track submenu, Video tracks,
Marker tracks and ruler tracks will automatically be placed in the up-
per part of the Track list.

All other types of tracks will be placed in the lower part.
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* If you add tracks from the context menu invoked by right-clicking
(Windows) or [Citrl]-clicking (Mac OS X) in the Track list, tracks will
be added to the part of the Track list in which you click.

* You can move any type of track from the lower Track list to the upper
and vice versa by right-clicking or [Ctrl]-clicking it in the Track list and
selecting “Toggle Track List” from the context menu.

* If the Track list already contains tracks of the type Video, Marker or
Ruler, these will automatically be moved to the upper part when you
divide the Track list.

*  You can resize the upper part by clicking and dragging the divider be-
tween the Track lists.
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Switching between musical or linear time base
Tracks can be either “musical” (tempo) or “linear” (time) based.

*  On atrack using linear time base, the events will be positioned on specific
time positions — changing the playback tempo will not affect the time position
of events.

» On atrack using musical time base, the positions of events are represented as
meter values (bars, beats, 1/16th notes and ticks, with 120 ticks per 1/16th
note). If you change the playback tempo, the events will play back at an earlier
or later time.

Whether to use musical or linear time base depends on the type of
project and recording situation. By default, all track types featuring a
time base setting use linear time base. However, you can change this
setting individually for each track. This is done by clicking the musical/
linear time base button in the Inspector or Track list. Musical time base
is indicated by a note symbol, while linear time base is indicated by a
clock symbol.

The musical/linear time base button.
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Linear time base selected. Musical time base selected.

[ Note that internally, events on musical time based tracks use the same
high precision for positioning (64 bit floating point values) as linear time
based events.

However, switching between linear and musical time base results in a very
small loss of precision (introduced by the mathematical operations used
for scaling values in the two different formats). Therefore you should avoid
switching repeatedly between the two modes.

For more information about tempo changes, see page 636.
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Adding events to a track

There are a number of ways to add events to a track:

+ By recording (see page 39).
This is possible for audio and MIDI tracks.

» By selecting “Audio File..."” or “Video File..." from the Import submenu on the
File menu.
This opens a file dialog, allowing you to locate the file you wish to import. When you
import a file this way, a clip is created for the file and an event that plays the whole clip
is added to the selected track, at the position of the project cursor.
You can also import MIDI files by using the Import submenu, but this works in a slightly
different way (see page 770).

By grabbing audio CD tracks and converting them to audio files (see page 777).

* By importing only the audio portion of a video file and converting it to an audio
file (see page 746).

* By using Copy and Paste on the Edit menu.
This allows you to copy all kinds of events between projects. You can also copy events
within the project, from the Audio Part Editor or Sample Editor.

* By drawing.
Some types of events (markers and automation events) can be drawn directly into the
Project window. For audio and MIDI tracks, you can draw parts (see page 116).

» By dragging files and dropping them on the track at the desired position.
You can create events by dragging and dropping from the following locations:

* The Desktop.

*  The Pool.

* A Library (A Pool file that is not attached to a project).

* The Project window of another open project.

* The Audio Part Editor of any open project.

* The Sample Editor of any open project — press [Ctrl]/[Command] and drag to
create an event of the current selection, or click in the left column of the region
list and drag to create an event from a region.

* The “Find media” dialog.

While you drag the clip in the Project window, its position will be indicated by a
marker line and a numerical position box. See also page 425.
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Audio file import options

When you are importing audio files there are a number of options con-
cerning how the files should be treated by Cubase SX/SL:

* You can choose to copy the file into the project's audio folder and have the
project make reference to the copied file rather than the original file. This
helps you keep your project “self-contained”.

* You can choose to split stereo- and multi-channel files into a number of mono
files.

* Furthermore, you may want all files in the project to have the same sample rate
and sample size (resolution).

The Preferences dialog (Editing — Audio page) contains a setting that
lets you decide which options, if any, to use. Select the desired option
on the “On Import Audio Files” pop-up:

On Impart Audio Files

Open Optio

| v Open Options Dialog
|Jse Settings
[TeERTET End L'culr%tu Froject IF Meeded

chany

L1 Split vt channe! files

*  Open Options Dialog.
An Options dialog appears when you import, allowing you to select whether you want
to copy the files to the Audio folder and/or convert them to the project settings. Note:

- When importing a single file of a format other than the project settings, you can spec-
ify which properties (sample rate and/or resolution) should be changed.

- When importing multiple files at the same time, you can select to have the imported
files automatically converted if necessary, i.e. if the sample rate is different than the
project’s or the resolution is lower than the project setting.
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* Use Settings.
No Options dialog will appear when you import. Instead, you can choose to make any
of the options below the pop-up the standard action(s). Activate any number of the fol-
lowing options to have them performed automatically each time you import audio files:

Option Description

Copy Files to Working If files are not already in the project’s audio folder they are
Directory copied there before being imported.

Convert and Copy to If files are not already in the project’s audio folder they are
Project If Needed copied there before being imported. Furthermore, if the

files have a different sample rate or a lower resolution than
the project settings, they are automatically converted.

Split multi channel files If you import a multi-channel audio file (including two-chan-
nel stereo files), it will be split into a number of mono files —
one for each channel — which are placed on separate, au-
tomatically created mono tracks.

Creating parts

Parts are containers for MIDI or audio events. If you record MIDI, a
MIDI part is automatically created, containing the recorded events.
You can also create empty audio or MIDI parts and later add events to
them. There are two ways to do this:

* Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

* Double click with the Arrow tool on a MIDI or audio track, between the
left and right locator.

A
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To add events to a MIDI part, you use the tools and functions in a MIDI
editor (see page 530). Adding events to audio parts is done in the Au-
dio Part Editor (see page 387) by pasting or by using drag and drop.

* You can also gather existing audio events into a part, by using the
“Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the same track. To
remove the part and make the events appear as independent objects on the track
again, select the part and use the “Dissolve Part” function on the Audio menu.
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Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with
the Speaker tool:

0 When auditioning, audio will be routed directly to the assigned Output
bus, bypassing the audio channel’s settings, effects and EQs.

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same icon. If the rightmost tool
icon on the toolbar isn't a Speaker symbol, first click on the icon to select it, then click
again and select “Play” from the pop-up menu that appears.

SENETAN

2. Click where you want playback to start, and keep the mouse button
pressed.
Only the track on which you click is played back, starting at the click position.

3. Release the mouse button to stop playback.
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Scrubbing

The Scrub tool allows you to locate positions in the audio by playing
back, forwards or backwards, at any speed:

1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same icon. If the rightmost tool
icon on the toolbar isn't a “Scrub symbol”, first click on the icon to select it, then click
again and select “Scrub” from the pop-up menu that appears.

R X G A

2. Click at the desired position and keep the mouse button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. The speed
and pitch of the playback depends on how fast you move the pointer.

You can adjust the responsiveness of the Scrub function in the Prefer-
ences dialog (VST page).

* |tis also possible to “scrub” the whole project with the Jog wheel on the
Transport panel.
See page 33.
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Editing parts and events

This section describes techniques for editing in the Project window. If
not explicitly stated, all descriptions apply to both events and parts,
even though we use the term “event” for convenience.

*  When you are using the tools for editing, you can in many cases get ad-
ditional functions by pressing modifier keys (e.g. pressing [Alt]/[Option]
and dragging with the Arrow tool creates a copy of the dragged event).
On the following pages, the default modifier keys are described - you can customize
these in the Preferences dialog on the Editing —Tool Modifiers page (see page 813).

Selecting events

Selecting events is done using any of the following methods:

* Use the Arrow tool.
The standard selection techniques apply.

¢ Use the Select submenu on the Edit menu.
The options are:

Option Description

All Selects all events in the Project window.

None Deselects all events.

Invert Inverts the selection — all selected events are deselected and

all events that were not selected are selected instead.

In Loop Selects all events that are partly or wholly between the left
and right locator.

From Start to Cursor ~ Selects all events that begin to the left of the project cursor.
From Cursor to End Selects all events that end to the right of the project cursor.
Equal Pitch These are available in the MIDI Editors (see page 539).

All on Selected Tracks Selects all events on the selected track.

Select Event This is available in the Sample Editor (see page 367).
Left/Right Selection These two functions are only used for range selection editing
Side to Cursor (see page 135).

O Note that these functions work differently when the Range Selection tool
is selected (see page 135).
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* Select all events on a track by right-clicking in its Track list and select-
ing “Select All Events” from the pop-up menu that appears.

* You can also use the arrow keys on the computer keyboard, to select
the closest event to the left, right, above or below.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing
you to select several events.

* If the option “Auto Select Events under Cursor” is activated in the
Preferences dialog (Editing page), all events on the selected track(s)
that are “touched” by the project cursor are automatically selected.
This can be helpful when rearranging your project, since it allows you to select whole
sections (on all tracks) by selecting all tracks and moving the project cursor.

* ltis also possible to select ranges, regardless of the event and track

boundaries.
This is done using the Range Selection tool (see page 135).

Moving events

To move events in the Project window, use the following methods:

* Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. You can only
drag events to tracks of the same type. If Snap is activated, this determines to which
positions you can move the events (see page 140).
Note also, that you can restrict movement to be either horizontal or vertical only, by
holding down [Ctrl]/[Command] while dragging.

O You will note that there is a slightly delayed response when you move an
event by dragging. This helps you avoid accidentally moving events
when you click on them in the Project window. You can adjust this delay
with the Drag Delay setting in the Preferences dialog (Editing page).

» Select the event and edit the Start position in the info line.
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Use the “Move to” functions on the Edit menu.
The following functions are available:

Function Description

Move to Cursor  Moves the selected event to the project cursor position. If there are
several selected events on the same track, the first event will start at
the cursor, and the following will be lined up end-to-start after the
first one.

Move to Origin ~ Moves the selected events to their original positions, i.e. the posi-
tions at which they were originally recorded.

Move to Front, This function doesn't actually change the position of the events, but
Move to Back moves the selected events to the front or back, respectively. This is
useful if you have overlapping events, and want to see one that is
partially obscured.
For audio events, this is an extra important feature, since only the
visible sections of events will be played back. Moving an obscured
audio event to front (or moving the obscuring event to back) will al-
low you to hear the whole event on playback.
Note that it is also possible to use the “To Front” function on the
event context menu for this (although this works in a different way,
see page 56).

Use the Nudge buttons in the toolbar.
These move the selected events to the left or right. The amount of movement depends on
the selected display format (see page 99) and the value set on the Grid pop-up menu.

1:40:00

Here, clicking this button will move the Event 2 frames to the right.

When the Range Selection tool is used, the Nudge buttons move the se-
lection range (see page 137).

The Nudge buttons are not visible in the toolbar by default.

You can decide which items should be visible by right-clicking (Windows) or [Ctrl]-click-
ing (Mac OS X) in the toolbar and checking them in the pop-up menu that appears. See
page 792 for more information.
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Duplicating events
Events can be duplicated in the following ways:

* Hold down [Alt]/[Option] and drag the event to a new position.
If Snap is activated, this determines to which positions you can copy the events (see
page 140).

3 If you hold down [Ctrl]l/[Command] as well, movement direction is re-
stricted to either horizontal or vertical. That means if you drag an event
vertically it can not be moved horizontally at the same time.

* Audio and MIDI parts can also be duplicated by pressing [Alt]/[Option]
+ [Shift] and dragging.
This creates a shared copy of the part. If you edit the contents of a shared copy, all
other shared copies of the same part are automatically edited in the same way.

i by e
Sax Sax Sax

Shared copies are indicated by showing the name in italic text and an icon in the
right corner of the part.

Note:

*  When you duplicate audio events, the copies are always shared. This means
that shared copies of audio events always refer to the same audio clip (see
page 333).

*  You can convert a shared copy to a real copy by selecting “Convert to Real
Copy" from the Edit menu. This creates a new version of the clip (that can be
edited independently) and adds this to the Pool. Note that no new files are
created by this operation — for that you need to use the “Bounce Selection”
function from the Audio menu (see page 436).

* Selecting “Duplicate” from the Edit menu creates a copy of the se-
lected event and places it directly after the original.
If several events are selected, all of these are copied “as one unit”, maintaining the rel-
ative distance between the events.

* Selecting “Repeat..."” from the Edit menu opens a dialog, allowing you to
create a number of copies (regular or shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the number of copies.
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*  You can also perform the Repeat function by dragging: Select the
event(s) to repeat, press [Alt]/[Option], click the handle in the lower
right corner of the last selected event and drag to the right.

The longer to the right you drag, the more copies are created (as shown by the tooltip).

o :

Repeat Count: 4

* Selecting “Fill Loop” from the Edit menu creates a number of copies
starting at the left locator and ending at the right locator.
The last copy is automatically shortened to end at the right locator position.

O A

I
18 3

17

Saxn| Saxn| Saxn| Saxn| Saxn] 3

Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in again, using
the functions on the Edit menu.

*  When you paste an event it is inserted on the selected track, positioned
so that its snap point is aligned with the cursor position.
If the selected track is of the wrong type, the event will be inserted on its original track.
See page 140 for information about the snap point.

* If you use the “Paste at Origin” function, the event is pasted at its orig-
inal position (the position from which you cut or copied it).

Renaming events

By default, audio events show the name of their clip, but you can enter
a separate descriptive name for separate events if you like. This is done
by selecting the event and typing in a new name in the “Description”
field in the info line.

* You can also give all events on a track the same name as the track by
changing the track name, holding down a modifier key and pressing
[Return].

See page 109.
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Splitting events

You can split events in the Project window in the following ways:

* Click with the Scissors tool on the event you want to split.
If Snap is activated, this determines the exact split position (see page 140). You can
also split events by pressing [Alt]/[Option] and clicking with the Arrow tool.

* Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no events are se-
lected, all events (on all tracks) that are intersected by the project cursor will be split.

* Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

* If you split a MIDI part so that the split position intersects one or several
MIDI notes, the result depends on the option “Split MIDI Events” in the
Preferences dialog (Editing page).

If the option is activated, the intersected notes will be split (creating new notes at the
beginning of the second part). If it is deactivated, the notes will remain in the first part,
but “stick out” after the end of the part.

Gluing events together

Clicking on an event with the Glue Tube tool glues it together with the
next event on the track. The result is a part containing the two events,
with one exception:

* If you first split an event and then glue the two sections together again
(without moving or editing them first), they become a single event again.
In other words, gluing can create a single event if the two events are lined up end to
start and play a continuous section of the same clip.
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Resizing events

Resizing events means to move their start or end positions individu-
ally. In Cubase SX/SL, there are three types of resizing:

Resizing type Description

Normal Sizing The contents of the event stay fixed, and the start or
end point of the event is moved to “reveal” more or
less of the contents.

Sizing Moves Contents The contents follow the moved start or end of the
event (see the figure below).

Sizing Applies Time Stretch The contents will be time stretched to fit the new event
length (see separate description on page 127).

To select one of the resizing modes, select the Arrow tool and then
click again on the Arrow tool icon on the toolbar. This opens a pop-up
menu from which you can select one of the resizing mode options.

e JER ey R X

w NMarmal Sizing
SizingMoves Contents
B Sizin plies Time Stretch

The icon on the toolbar will change, indicating the selected resizing mode.

The actual resizing is done by clicking and dragging the lower left or
right corner of the event. If Snap is activated, the Snap value deter-
mines the resulting length (see page 140).

22700

Normal sizing.
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Sizing moves contents.
* If several events are selected, all will be resized in the same way.

* You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the audio under the
pointer is played back (scrubbed) while you drag.

* ltis also possible to resize events by using the Trim buttons (located
in the Nudge palette) on the toolbar.
This will move the start or end position of the selected Event(s) by the amount set on
the G